3D Level Scanner
Multi-Scanner System
Operating Instructions

- For large diameter bins
- Measures and maps material surface
- 3D visualization of contents
Contents

1 ABOUT THIS DOCUMENT .......................................................................................................................... 3
  1.1 SYMBOLS IN USE ................................................................................................................................. 3
  1.2 FOR YOUR SAFETY .................................................................................................................................. 3
  1.3 STORAGE AND TRANSPORT .................................................................................................................. 3

2 MVL – MULTI SCANNER SYSTEM ............................................................................................................. 4
  2.1 SYSTEM OVERVIEW AND COMPONENTS ............................................................................................. 4
  2.2 ADVANTAGES .......................................................................................................................................... 4
  2.3 SYSTEM REQUIREMENTS ....................................................................................................................... 5
  2.4 MODELS .................................................................................................................................................. 5
  2.5 COMMISSIONING METHOD .................................................................................................................... 5

3 PHYSICAL INSTALLATION .......................................................................................................................... 8
  3.1 LOCATION AND POSITIONING GUIDELINES .......................................................................................... 8
  3.2 3DLEVELSCANNER ORIENTATION ......................................................................................................... 9
  3.3 SITE PREPARATIONS .............................................................................................................................. 10
  3.4 ASSEMBLY AND MOUNTING ................................................................................................................ 11
  3.5 WIRING .................................................................................................................................................. 14

4 FIRST-TIME ACTIVATION .......................................................................................................................... 17
  4.1 LOCAL USER INTERFACE ...................................................................................................................... 17
  4.2 SWITCHING ON THE SCANNER .............................................................................................................. 18
  4.3 FIRST-TIME ACTIVATION STEPS ......................................................................................................... 18
  4.4 INITIAL SETUP PROCEDURE ................................................................................................................ 19

5 CONNECTION METHODS .......................................................................................................................... 20
  5.1 4-20MA CONNECTION .......................................................................................................................... 20
  5.2 RS-485 COMMUNICATION ..................................................................................................................... 20
  5.3 TCP/IP COMMUNICATION ..................................................................................................................... 21

6 MVL CONTROLLER ..................................................................................................................................... 22
  6.1 MOUNTING THE MVL CONTROLLER .................................................................................................... 22
  6.2 CONTROLLER INTERIOR ....................................................................................................................... 23
  6.3 WIRING THE MVL CONTROLLER .......................................................................................................... 25
  6.4 CONNECTING TO THE MVL CONTROLLER ........................................................................................ 25
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.5</td>
<td>Getting Started with the MVL Controller</td>
<td>26</td>
</tr>
<tr>
<td>7</td>
<td>Configuring the 3DLevelScanner</td>
<td>27</td>
</tr>
<tr>
<td>7.1</td>
<td>Connecting to the 3DLevelScanner</td>
<td>27</td>
</tr>
<tr>
<td>7.2</td>
<td>Configuration and Analysis</td>
<td>28</td>
</tr>
<tr>
<td>7.3</td>
<td>Additional Functions in 3DLevelManager</td>
<td>34</td>
</tr>
<tr>
<td>7.4</td>
<td>3DLevelManager Software Menus</td>
<td>36</td>
</tr>
<tr>
<td>8</td>
<td>System Monitoring Using 3DVision</td>
<td>60</td>
</tr>
<tr>
<td>8.1</td>
<td>Client-Server Connection</td>
<td>60</td>
</tr>
<tr>
<td>8.2</td>
<td>First Time Running of 3DVision</td>
<td>61</td>
</tr>
<tr>
<td>8.3</td>
<td>3DVision Software Navigation</td>
<td>69</td>
</tr>
<tr>
<td>8.4</td>
<td>Advanced Tools</td>
<td>77</td>
</tr>
<tr>
<td>8.5</td>
<td>Software Menus</td>
<td>88</td>
</tr>
<tr>
<td>8.6</td>
<td>Using 3DLevelManager with 3DVision</td>
<td>92</td>
</tr>
<tr>
<td>A</td>
<td>Appendix A: Additional Information</td>
<td>94</td>
</tr>
<tr>
<td>9.1</td>
<td>Using 3DLevelScanner Onboard Buttons</td>
<td>94</td>
</tr>
<tr>
<td>9.2</td>
<td>3DLevelScanner Accessories</td>
<td>94</td>
</tr>
<tr>
<td>9.3</td>
<td>Preventive Maintenance Procedure</td>
<td>98</td>
</tr>
<tr>
<td>9.4</td>
<td>Recommended Tools</td>
<td>99</td>
</tr>
<tr>
<td>9.5</td>
<td>3DLevelScanner Specifications</td>
<td>99</td>
</tr>
<tr>
<td>9.6</td>
<td>MVL Controller Specifications</td>
<td>104</td>
</tr>
<tr>
<td>B</td>
<td>Appendix B: Standards &amp; Approvals</td>
<td>105</td>
</tr>
</tbody>
</table>
1 About this Document

This manual provides detailed product information, installation, configuration and operation instructions for the MVL Multi Scanner system including the 3DLevelScanner, 3DLevelManager software and 3DVision software. The manual is designed for trained personnel. Please read it entirely and carefully before proceeding with installation of the multi scanner system.

1.1 Symbols in use

The following symbols indicate different sections of additional information as follows:

- **IMPORTANT**: An indication for additional information, tips, hints or an indication of helpful additional knowledge.

- **EX APPLICATION**: An indication of special instructions relevant to installations in hazardous locations.

1.2 For your safety

**Authorized Personnel**

All operations described in this manual should be performed by authorized and trained personnel only. For safety and warranty reasons, any internal work on the devices must be performed by manufacturer authorized personnel only.

**Appropriate Use**

The 3DLevelScanner™ is a device designed for continuous level or volume measurement.

**Warning about Misuse**

Inappropriate or incorrect use of the device can give rise to application-specific hazards, e.g. vessels overfill or damage to system components through incorrect mounting or adjustment.

**General Safety Instructions**

The 3DLevelScanner™ is a high technology device which requires strict observance of standard regulations and guidelines. The user must take note of the safety instructions detailed in this manual, as well as country-specific installation standards, and all common safety regulations and accident prevention rules.

1.3 Storage and transport

The scanner is protected by special packaging during transport, and is guaranteed to handle normal loads during transport.
2 MVL – Multi Scanner System

2.1 System overview and components

The MVL System components:

The MVL System has been specially designed for wide silos, open bins and warehouses where the diameters or areas to cover are exceptionally large.

The MVL system consists of multiple 3DLevelScanner units mounted in a manner allowing scanners to cover areas as large as possible, while enhancing volume measurements accuracy provided by BinMaster standard single-unit scanners.

The system is comprised of MVL model type 3DLevelScanners and an industrial computer based MVL Controller, enclosed in a metal cabinet with direct RS-485 connection to the scanners.

The MVL Controller is comprised of a lockable metal cabinet which contains:

- Industrial computer unit with the following connectors:
  - 4 x USB ports (for external hard drive, mouse or keyboard connection)
  - 2 x Ethernet RJ-45 NIC cards
  - PS/2 Mouse/Keyboard connector
  - VGA display connector (DB15)
  - 2 x RS-232 ports (DB9)
  - One speakers/headphones output
  - Power supply port wired to the terminal blocks
- USB to RS-485 converter for connecting the computer to the scanners
- 4-Port terminal block for wiring
- Two M25 cable glands for cables insertion
- Grounding Screw

NOTE: Two NIC RJ-45 Ethernet ports are available for local computer connection (using cross-over cables) and local area network connection. The ports are physically located at the lower part of the controller.

2.2 Advantages

The Multi-Scanner Controller features several major functions which bring a synergetic quality to the MVL scanners positioned in the same bin:

- Synchronizing the scanner transmissions while preventing mutual scanner interference and keeping SNR performance uncompromised
- Returned echoes from all scanners in the system are considered
- Generating a complete, merged visualization of the entire bin
 Updating and synchronizing 4-20mA outputs from all scanners to the overall content percentage, requiring only one scanner to be connected to the control room

 Accurate, timed inventory monitoring enables material ordering to meet production needs, avoiding costly emergency fills

### 2.3 System requirements

The MVL System is designed for large silos, domes, open bins, warehouses, etc., where a single point measurement device cannot provide valuable information, and where a single scanner is too small to cover the vessel dimensions and proportions.

For a recommended and optimal MVL system configuration, BinMaster Technical Support advises installing the scanners at the suggested locations and following the instructions in this manual. All scanners must be daisy-chained with RS-485 links to the MVL Controller. A single 4-20mA pair has to be wired from only one of the chained scanners to the PLC/DCS/SCADA/Etc. There is no preference to which scanner the 4-20mA is connected to.

The MVL Controller cabinet has to be installed indoors, mounted on a wall and wired to the scanners and a power supply for the computer operation. A single 24VDC power supply is recommended for powering the computer and the scanners. Power consumption is an important consideration. The computer is rated 40W with 24VDC power supply, and each scanner is rated 1.5W with the same power supply.

### 2.4 Models

The MVL system is comprised of multiple 3DLevelScanner units and an MVL Controller. The two basic systems, MVL2 and MVL4 consist of 2 and 4 scanners respectively.

The MVL System can include any number of scanners in order to cover the material area and to provide the best calculated accuracy.

For deciding the suitable application, it is advised to contact BinMaster Technical Support for assistance. When contacting BinMaster Technical Support, the following information will be required:

- Detailed drawings of the vessel
- Locations of emptying and filling points
- Emptying and filling methods
- Material type and angle of repose
- Maximum level of material inside the vessel
- Maximum temperature and humidity inside the vessel
- Internal movement and construction inside the vessel

### 2.5 Commissioning Method

When the system is operating and providing measurements, the MVL Controller is used for running the 3DVision Server application that synchronizes and merges the scanners and delivers data to the 3DVision Clients installed on computers with access to the MVL Controller. It is also recommended to use the MVL Controller Computer for configuration and adjustments, and for executing the 3DLevelManager installed in it.
The recommended method of operation and steps to be taken during the installation of a multi scanner system is detailed below.
The list is organized in a chronological order and may be used as a checklist to verify all steps done in the proper order.
These steps are to be taken during on-site commissioning of the MVL system.

1. **3DLevelScanner installation:**
   - Make sure all required documentation is available: AAF, IPF and Vessel Drawings
   - Mounting location as suggested by BinMaster with the actual 3DLevelScanners mounting positions
   - Perform manual measurements of the vessel dimensions, and compare results to the drawings
   - Power up all scanners and check polling addresses
   - Check 24VDC input to all scanners
   - Check RS-485 link between scanners and the MVL Controller. Make sure the resistance between D+ and D- is 60 ±5% Ohm
   - Check 4-20mA connection to the local PLC.
   - Set polling addresses, make sure each scanner has a different polling address and one of the scanners is set with polling address of 00
   - Write down the polling addresses on the vessel drawings for all scanners
   - Verify all scanners for proper functioning after power up. This can be verified by connecting each scanner directly to a computer
   - Verify sound signals transmission from all scanners
   - Get material status (level/distance/volume) according to the process manager
   - Get all required information from the process manager in order to complete the scanner configuration

2. **MVL Controller:**
   - Mount the MVL controller cabinet indoors. Ensure it is accessible for power supply, Ethernet connections and for maintenance
   - Verify proper connection of the MVL controller to a proper power supply
   - Connect the provided crossover Ethernet cable (Ethernet port #2) from the MVL controller to a local laptop or other computer
   - Set the IP Address on the laptop to static IP: 192.168.99.xx (where xx can be any number between 001 to 255 except 99) and subnet mask 255.255.255.0. Do not forget to restore to previous state once installation is complete.
   - Install UltraVNC version 1.0.8.2 on the laptop
   - Using the UltraVNC Viewer, take control over the MVL controller using IP address 192.168.99.99 and password ‘apm’. It is recommended to use UltraVNC version 1.0.8.2
   - Make sure the MVL controller is installed with the latest SW versions of the 3DLevelManager and 3DVision. If it is not, contact BinMaster Technical Support for assistance
3. **3DLevelManager and 3DLevelScanner Configuration:**
- Turn off the 3DVision Server software
- Execute 3DLevelManager and connect to all scanners using RS-485 (or TCP/IP, according to the actual connection) in Multiple mode
- From the computer Device Manager, locate the Serial COM Port used for the USB-to-RS-485 convertor connection
- Verify latest firmware version and proper connection for all scanners
- Configure the first scanner and save the configuration file
- Proceed with the configuration for the rest of the scanners (or by uploading the first scanner configuration and changing the name tag, scanner location, device horizontal angle, and setting the full and empty calibration levels accordingly)
- Make sure all scanners have exactly the same configuration for: dimensions, filling points, rates and material slope
- Specifically check the full and empty calibration levels
- Perform grades analysis for all scanners and verify correct readings. Map false echoes, fine tune and adjust as needed

4. **3DVision:**
- Turn off the 3DLevelManager
- Execute 3DVision Server
- Execute 3DVision Client
- Connect the Client to the local server (using 'localhost' as the Server Address, 22222 as the default IP address and 'admin' / 'admin' for user name and password)
- Create a single site project with a single vessel and the quantity of scanners (2 and above)
- Set the connection method and type
- Connect the 3DVision to the scanners by pressing the Connect Vessel button
- Verify connection of all scanners and that the vessel indicator is green, and no warning or alerts are indicated
- The system is ready for operation

5. **3DVision Clients:**
- Connect the MVL Controller to the local area network using Ethernet port #1
- Request local IT to ensure the following TCP Ports are open and will not be blocked by any firewall or antivirus: 22220, 22221, 22222 and 22223
- Configure the network card to a static IP address provided as by the local IT. Take note of the MVL Controller IP address - it will be required for all additional 3DVision Clients
- Install 3DVision Client on all required computers on same local area network (LAN) or consult with the local IT regarding the method of connection
- Establish a connection to the 3DVision Server from the 3DVision Client running on the local PC using the Server IP address of the MVL controller IP written beforehand
- Ensure the system and the vessel are connected
3 Physical Installation

This chapter describes the necessary steps for proper installation of the 3DLevelScanner in an MVL system, beginning with important pre-installation considerations such as environmental conditions, correct positioning and orientation, throughout the mounting and configuration process.

3.1 Location and positioning guidelines

When choosing the proper location of the 3DLevelScanner in an MVL system, consider every aspect of the vessel and contained materials, including the silo or vessel dimensions, type of material and angle of repose, filling and emptying point locations, maximum level of the material, internal construction and moving parts and any other consideration which may possibly affect the scanner performance. Contact BinMaster Technical Support for assistance with finding proper positioning locations.

Installation location

Choosing a proper installation location for the 3DLevelScanner is an important part of the installation process. Wrong location may result in erroneous measurements and loss of performance.

Contact BinMaster Technical Support for further assistance.

The following factors must be taken into consideration when choosing the installation position: vessel dimensions, filling and emptying point locations, internal structure or support and other restrictions related to vicinity to electrically noisy devices (such as electrical motors) and any other item which may affect a proper operation of the scanner.

Installing the scanner at the center of the vessel is not recommended, since a perfect symmetry from all sides toward the scanner may affect the echoes distinction.

Measuring range

The measuring range is set in the scanner and defined by silo dimensions and the full and empty calibration levels. These levels set the 100% (20mA) and 0% (4mA) values relatively.

The scanner measurements are calibrated to the top of the vessel body. If the scanner is lowered, or mounted with neck extension or head-body separation, it is important to adjust all measurements to the top of the body.
Moisture and water condensation

**IMPORTANT:** Use the recommended cable glands and tighten the cable connection. For additional protection against moisture, lead the connection cable downward in front of the cable entry. Rain and condensed water can thus drain off. This applies mainly for mounting in areas where moisture is expected (e.g., by cleaning processes), or on cooled or heated vessels.

**NOTE:** If the material level reaches the antenna, buildup may form inside the horn over time and cause measurement errors and damage to the membranes.

**NOTE:** the 3DLevelScanner has a 500mm (20”) of dead zone (or blanking zone).

Pressure

The process fitting must be sealed in the case of a low pressured vessel. Before usage, verify that the sealing material is resistant to the stored medium. The maximum allowed pressure (refer to page 99: 3DLevelScanner Specifications) is indicated on the scanner’s label.

**IMPORTANT:** The scanner cannot be mounted at a distance lower than 500mm (20") from the wall. When choosing the installation location, consider the filling and emptying points.

### 3.2 3DLevelScanner Orientation

**Mounting direction**

Mounting of the 3DLevelScanner at a specific direction is important. The ridge on the horn body, and the notch on the top of the thread (representing antenna no.1) should be directed toward the center of the vessel as shown below.

![Mounting Direction and 0° Label Location](image)

**Standpipe mounting**

When mounting the scanner using a standpipe, the positioning height should allow at least 10mm (0.4”) for the antenna end protrudes to protrude out of the standpipe as shown in the figure to the right.

![10mm (0.4 in.)](image)
**IMPORTANT:** Any obstruction as well as rails, frames or support beams should never interfere with the acoustic beam transmitted and received, as shown in the figure to the right.

[Image: Wrong Correct]

### Inflowing material

Do not mount the scanners in or above the filling stream, not too far from the stream, and not in the direction of the filling stream if diagonal, in order to avoid the flowing material from damaging the scanner. The scanner should be located with a clear line of sight to the top of the material at high levels, not to be affected by the filling stream or the noise it generates.

[Image: Wrong Correct]

### Fitting

The fitting area should be prepared in order to keep the horns/antennas vertically positioned to the ground, as shown in the figure to the right.

[Image: Wrong Correct]

### 3.3 Site Preparations

**IMPORTANT:** The site preparations described in this section must be complete and verified prior to installation. For optimal installation, ensure that the 3DLevelScanner can be positioned and fitted according to the guidelines described in the beginning of this chapter.

For a list of recommended items preparation prior to installing the 3DLevelScanner, refer to page 99: Recommended Tools.

Before installing, make sure the following preparations have been completed:

**Power**
- 3DLevelScanner chassis connected to the facility grounding (important for protection).
A 24VDC (at least 1.5 Watt per scanner) power supply prepared and ready to connect to all scanners in the MVL system.

The 3DLevelScanner is a 4-Wire device. The voltage supply and data output (4-20mA) are carried along by two separate two-wire connection cables, to be wired from only one scanner in the MVL system.

Communications
- Route the communication cables in proper conduits and use a proper cable type.
- RS-485 cables should be of twisted-pair type, shielded, with 120 Ohm impedance and approved for RS-485 communications.
- 4-20mA cables should be rated for analog signals, twisted-pair, low resistance and shielded.

3.4 Assembly and Mounting

Package Contents
The supplied MVL package includes:
- 3DLevelScanners – according to the MVL System purchased
- MVL Controller running Windows XP and fully installed with all relevant applications
- Documentation
- CD with 3DVision, 3DLevel Manager software programs and marketing materials
- Ex-specific safety instructions (with Ex models)
- Certificates as applicable

Included components
The 3DLevelScanner includes the following components:

- 3DLevelScanner Body: includes three antennas, transducers and temperature sensor.
- 3DLevelScanner Head: includes the electronic board with LCD display, wiring connections and cable glands.

Flange preparation
Prior to the installation of the 3DLevelScanner, an installation flange should be prepared. The flange must have a 52mm (2.05”) hole for the scanner body thread insertion.
Installing the Flange

1. Verify the O-Ring on the neck tube remains in place as shown:

2. Use 18” adjustable pliers or 24” wrench to untighten and remove the nut from the neck tube.

3. Place flange over the neck tube, insert until placed as shown:

4. Replace the nut and tighten it over the neck tube to the flange, using an 18” adjustable wrench. Make sure the scanner is well tightened to the flange to prevent vibration and for proper sealing. When mounting the scanner body and flange to the silo standpipe, make sure the scanner is facing the center of the silo as described in 3DLevelScanner Orientation on page 9.

Installing the Scanner Head

1. Unpack the scanner head. Untighten the four screws of the housing rear panel using a 4mm hex key, and remove the rear panel. The screws are of captive type and will not fall off.

2. Remove the cable clamp located at the bottom inside the scanner as shown.

3. Gently insert the antenna cable through the scanner head. Make sure not to damage the (white) cable connector. This connector connects the transmission signal from the electronic board to the transducers. Damage to the connector or to
the wires will result with malfunctioning operation of the scanner.

4. Insert the scanner head onto the neck tube.

**IMPORTANT:** When inserting the scanner head onto the neck tube, make sure to push the head all the way down until it fully contacts the top of the neck tube.

**NOTE:** It is recommended to lubricate the O-Ring on the neck tube prior to installing the scanner head. This makes it easier to insert and properly locate the scanner head over the tube neck.

**NOTE:** The 3DLevelScanner head may be installed in six different positions.

5. Tighten the front screw using a 4mm hex key and a 13mm wrench.

6. Replace the cable clamp back to position, between the antenna cable and the electronic board.

7. **Carefully** connect the antenna cable connector back to the electronic board as shown.

   This connector allows the transmission signal from the electronic board to the transducers. Damaged connector or wires will result with malfunctioning operation of the scanner.

8. Leave the scanner open at this stage in order to complete the wiring.
3.5 Wiring

The MVL System allows two communication methods for connecting to the scanners: RS-485 or TCP/IP. Connections to different, external systems such as PLC or DCS and communications on RS485, ModBus or HART cannot be done directly and must be done using the 3DVision Server. For in-depth details about wiring and communication, refer to page 20: Connection Methods.

- Use 8-13mm (20 AWG) diameter cables to ensure proper and effective sealing of the cable gland entry opening.
- Select cables suitable for the application type (indoor or outdoor) and safety certified according to national regulations.

Communications

**NOTE:** If electromagnetic interference is expected, usage of a screened and twisted wired cable is recommended for the signal lines, which should be connected to the ground reference.

**CAUTION:** Always observe the following safety instructions:

Connections must be made only in the complete absence of line voltage.

If over-voltage is expected, overvoltage arresters should be installed.

Use only a safety-certified power supply with dual insulation between the primary and output for powering the unit. The power supply output rating must be limited to 20-32VDC, and supply sufficient current for the 3DLevelScanner devices.

In hazardous areas, take into consideration the appropriate regulations, conformity and type of approval certificates of the sensors and power supply units. Refer to the printed safety manual provided with the ATEX/FM approved 3DLevelScanner.

Power Supply

For power supply specifications, refer to page 99: 3DLevelScanner Specifications for full details.

Connection Procedure

1. Untighten the four screws of the scanner housing rear panel and remove the rear panel. The screws are of captive type and will not fall off.

2. Loosen the compression nut of the cable gland entry.
3 Insert the cable into the scanner through the cable gland and entry opening.

4 Remove approximately 10cm (4”) of the cable mantle and strip approximately 1cm (0.4”) the edge of each conductor.

5 Open the terminal block screws located inside the scanner housing using a thin flat (A3/32”) screwdriver. Insert the wire edges into the terminals according to the wiring plan detailed next, and fasten the terminal screws. Gently pull the wires to ensure they are securely connected.

6 Terminal block wiring diagram.
The tables below describe the connections. Refer to the following Local Connection and Multi-Drop Connection drawings for details.

<table>
<thead>
<tr>
<th>Left Connector</th>
<th>Ports</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS IN</td>
<td>+</td>
<td>Feed in power supply 20 – 32 DC</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>4…20mA</td>
<td>+</td>
<td>4 - 20 / HART Communications terminals</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Right Connector</th>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-485</td>
<td>+</td>
<td>RS-485 / ModBus RTU Communications terminals</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

7 Connect the external ground terminal with potential equalization to the external ground terminal of the scanner, located shown.
An internal ground connection is also possible using the inner connection as shown.

Tighten the compression nut over the cable gland entry opening. Verify that the sealing ring completely wraps the cable.

**IMPORTANT:** Gland compression nut tightening provides good sealing. It is necessary for the scanner to maintain IP67 requirements, and for extended scanner lifetime.

Attach the rear panel back to position at the rear of the scanner housing and tighten the four screws to secure it in place, using a 4mm hex key.

The 3DLevelScanner is ready for configuration.

**IMPORTANT:** 4-20mA – Use direct connection between the scanners and the plant (PLC/SCADA).

**IMPORTANT:** For a remote connection, connect the MVL controller to the local area network and to the internet.

**CAUTION:** Do not connect power supply to the 4-20mA or to the RS-485 ports.

The 3DLevelScanner is not a loop powered device but a 4-Wire device.

**WARNING:** The 4-20mA / HART lines should NOT be connected using multi-drop.
4 First-Time Activation

4.1 Local User Interface

Configuration and adjustment of the 3DLevelScanner must be done using the 3DLevelManager software. For detailed configuration procedure, refer to page 27: Configuring the 3DLevelScanner.

The 3DLevelScanner User Interface

The user interface includes a 4-line LCD display and the four keys located on the front side of the device, marked ESC, +, - and E.

Key functions are as follows:

- **ESC**: Navigates back within a function menu. Continuous 3 second press exits to the default screen.

- **+**: Navigates upwards in the navigation list. Navigates right within a function.

- **-**: Navigates downwards in the navigation list. Navigates left within a function.

- **E**: Navigates to the right when within a function group. Stores a value once configured.

The following, simultaneous key-press combinations perform special functions as follows:

- **+ E**: Increase/decrease the LCD display intensity.
- **- E**: Press and hold the E button, then use + or - buttons to increase or decrease the intensity of the display.

Operating menu

The operating menu consists of two levels:

- **Function groups**: The scanner functions are organized in groups. Available function groups are: Output Settings, Display Settings, Device Info and Device Reset.
Functions: Each function group consists of one or more functions. The functions may perform various actions or modify scanner setting parameters. Numerical values can be entered, and parameters can be selected and saved.

4.2 Switching on the scanner

Once the 3DLevelScanner is connected to the power supply and switched on, it initializes a self-test which lasts for approximately 30 seconds. When the initialization is complete, the following content is displayed allowing selecting a language and distance units:

1. The unit is turned on and is initializing for about 30 seconds, during which the display remains blank.

2. The version screen appears:
   - The value in <> describes the scanner model: S, M, MV or MVL.
   - FW Ver: firmware version
   - HW Ver: hardware version
   - Init. Please wait...
   - 3LEVELSCANNER <MV>
   - FW Ver: 03.00.00
   - HW Ver: 020

3. Once the startup process is complete, the following screen appears showing the current distance measurement.
   - The forth line displays the scanner tag name. By default, when the name has not been configured yet, this line remains empty.
   - Press [E] to return to the Main Menu.
   - Press [ESC] for 3 seconds to switch to the basic measurement screen.

4.3 First-time Activation Steps

The following list describes the actions to be taken on first-time activation of the scanner:

1. Connect power to the scanner. After about 30 seconds, the version screen appears.
2. After few seconds, the display switches to the current distance measurement screen.
3. Press [E] to enter the Main Menu.
4. From the Main Menu, choose Output Settings, by pressing the [E] button, and setting the polling address.

Following completion of the first-time activation tasks, use the 3DLevelManager software to establish the connection and to make all the necessary configurations.
4.4 Initial Setup procedure

Setting the scanner address

The sensor address setting is mandatory over a RS-485 Multi-drop bus (Daisy Chain). Addresses must be set prior to parameter adjustment.

1. At the Main Menu, scroll down to Output Settings option using the ▼ key and press ▶ to switch to the Polling Address configuration screen.

2. Use the ▼ key to switch between the two digits. Use the ◄ key to modify the value. The default polling address is 00. The polling address can range from 00 to 63. Press ▶ to store the modified address.
5  Connection Methods

The 3DLevelManager software allows choosing either RS485 or TCP/IP for communicating with the 3DLevelScanners.

5.1  4-20mA Connection

The 3DLevelScanner outputs the % of Volume as set during configuration and between the Full and Empty calibration levels. The 4-20mA current output is available through ports 3 and 4 of the left green connector (as shown in the drawing to the right). Ports 3 and 4 are the negative and positive poles, respectively.

The 4…20mA line is connected directly from the scanner mounted on the vessel to the PLC/DCS/Display or any other device.

In the MVL System, only one 3DLevelScanner 4-20mA output should be connected to the monitoring system. The 4-20mA output in all 3DLevelScanners has the same value.

**IMPORTANT:** This type of connection is active and not passive, hence the 3DLevelScanner is the active module and the PLC should be the passive module.

5.2  RS-485 Communication

The 3DLeveScanner includes an RS485 communication port. This type of connection allows the MVL Controller to communicate with the scanners over the RS-485 bus as well as communications to all scanners using a single connection to the computer running the software.

The use of a cable rated for RS-485 is required. The cable should be of shielded twisted pair type with 120 Ohm impedance. The overall length of the cable should not reach 1000m (3280ft).

All scanners must be connected in parallel mode through their RS-485 ports. Hence, all the '+1' (positive) ports of the RS-485 should be commonly connected and all the '-1' (negative) ports of the RS-485 should be commonly connected. The connection must be of Daisy-Chain type and include line termination resistors of 120 Ohm at the far ends of each chain (resistors are provided with the scanners) as shown on the figure below. The RS-485 cable in use must be compatible with RS-485 specifications, in general, have twisted pair, shielded and impedance of 120 Ohm.

Each Scanner must be configured with a different polling address.
5.3 TCP/IP Communication

The RS-485 bus can be converted for TCP/IP communication using a specific gateway adapter. TCP/IP to RS-485 converter installation should be done with any scanner, including the resistors and daisy-chain considerations.

NOTE: Consult BinMaster Technical Support for assistance regarding choosing a proper TCP/IP converter.
6 MVL Controller

The MVL System includes a dedicated computer (MVL Controller) - an industrial computer enclosed within a lockable metal cabinet, including terminal block connections for wiring of communications lines, power supply and the built-in RS-485 to USB converter module.

6.1 Mounting the MVL Controller

The MVL Controller metal cabinet is designed for wall mounting using 4 screws. The mounting location should be selected with considerations of the cabinet size and providing enough space allowing the door to open to the right.
6.2 Controller Interior

1. MVL Controller Computer
2. Power supply terminals, 1 for +24VDC, 2 for -24VDC (or GND)
3. USB to RS-485 convertor
4. RS-485 terminals, 3 for D+, 4 for D-
5. Spare DIN Rail for other components as 24V power supply, barriers, etc.

6. 2 x M20 Cable glands

1. Speaker Out

2. 2 x USB port

3. Ethernet #2 port – set to fixed IP Address: 192.168.99.99

4. Ethernet #2 port – set to dynamic IP Address

5. VGA port for external display

6. PS/2 port for mouse or keyboard

7. Power supply input connector
6.3 Wiring the MVL controller

The MVL Controller is provided pre-wired with one terminal block for all wiring connections:

- Power Supply to the computer
- RS-485 to the MVL System scanners

1. Connect the 24VDC power supply output to terminals 1 and 2 according to their polarity. These ports are pre-wired to the computer. Scanners power input may be connected to the same ports in parallel. Make sure the power supply is rated to provide at least 40W or more if scanners are connected. Refer to page 99: 3DLevelScanner Specifications for additional details.

2. Connect the RS-485 wires to terminals 3 and 4 according to the RS-485 connections in the scanners. Make sure the D+ wire is connected to D+ terminals of the scanner and the MVL controller. Connect the D- wire respectively.

6.4 Connecting to the MVL controller

Logging to the MVL System is required for configuration using 3DVision and 3DLevelManager. There are two different methods to connect to the MVL controller: Direct connection and Remote Control.

Direct connection: The MVL Controller contains connection ports for display, keyboard and mouse which allow direct connection and interaction with the computer.

Remote Control: Allows controlling the MVL Controller from a remote computer, where:

- The MVL Controller has 2 NIC cards, one with a predefined IP address and the other set to DHCP mode.
- The MVL Controller is provided with a cross-over Ethernet cable for connecting directly to an external computer by plugging in the Ethernet cable to Port 2 in the MVL Controller and to the NIC card in the other computer. The cable provided is 1m (3 ft.) long. Using a laptop for direct connection to the MVL controller is recommended.
- Following the physical connection, the NIC card on the other computer has to be set with static IP and subnet addresses for linking to the MVL Controller network.
NOTE: The MVL Controller Ethernet port 2 is set to 192.168.99.99 with subnet 255.255.255.0. The other computer has to be set to 192.168.99.xx where xx can be any number between 001 to 255, except 99.

- Once a successful connection between both computers is established, it is recommended to install UltraVNC to allow a remote connection. A Server version of UltraVNC is already installed in the MVL Controller.
- Start the UltraVNC and type in the MVL Controller IP Address: 192.168.99.99, the default password for the UltraVNC is 'apm'.
- Once logged in, the 3DLevelManager and the 3DVision can be executed and the necessary configurations can be performed.

6.5 Getting started with the MVL controller

Once interaction with the MVL Controller started, the computer desktop appears. The system is provided with a licensed Windows XP Professional and the following pre-installed applications: 3DVision, 3DLevelManager and UltraVNC. All installation files and firmware files are included in a folder located on the desktop. These files can be used for installation on other computers.

The recommended steps for MVL system installation completion are as follows:

1. Connect the 3DLevelManager to all scanners. Refer to page 27: Connecting to the 3DLevelScanner
2. Use the 3DLevelManager to update the 3DLevelScanner with up to date firmware version. Refer to page 55: Tools Menu
3. Use the 3DLevelManager to configure each scanner separately. Verify that all scanner configurations are identical in the same MVL System. Specifically verify that the dimensions and filling points are identical and all scanners have identical full and empty calibration levels on the same level. Refer to page 28: Configuration and Analysis
4. Fine tune each scanner to achieve optimal performance
5. Disconnect the 3DLevelManager from the scanners and start 3DVision
6. Define a new 3DVision project and establish connection with the scanners
7. Make sure that all scanners are connected and provide correct data
8. Install 3DVision Clients on other computers on the network and instruct the end user on 3DVision Client usage.

NOTE: Chapters 7 and 8 in this document describe the use of the 3DLevelManager and the 3DVision.
7 Configuring the 3DLevelScanner

7.1 Connecting to the 3DLevelScanner

The 3DLevelManager software is the recommended tool for configuring and establishing communications with 3DLevelScanner devices using RS-485 and TCP/IP.

Establishing a Connection

Press Device \(\rightarrow\) Manually Connect... (or, click the Reconnect button or press Ctrl+M) to initiate a connection between the 3DLevelManager and the connected scanners. This opens the connection box which lets you set the required communication properties and to establish a data connection between the software and the scanner.

In the Connection Method field, select the communications interface used for connecting the scanner to the computer and the software. In MVL systems, it is recommended to use either RS-485 or TCP/IP.

RS485 Connection

For more details, refer to section: 5.2 RS-485 Communication on page 20.

TCP/IP Connection

The TCP/IP option allows converting and transferring the RS-485 data over TCP/IP using compatible converter. When establishing a connection to the TCP/IP converter, the local IP address and the TCP port values must be set as defined in the converter.

Multiple Scanner Connection

When connecting several scanners in Daisy-Chain, the 3DLevelManager can be connected to all scanners and a specific scanner may be chosen to be viewed at any time.
For this type of connection, each scanner must be set with a different polling address. One scanner must be set with a polling address of 00.

### 7.2 Configuration and Analysis

Use the 5-stage configuration wizard for first-time configuration of the 3DLevelScanner.

**NOTES:**
- Prior to 3DLevelScanner configuration, verify that the 3DLevelScanner has the most recent firmware version installed.
- Make sure the operating mode is set to Technician mode before trying to open the Configuration Wizard. Technician mode password is ‘techAPM’.
- When working with scanners of firmware version above 3.1.0, the configuration wizard pops up automatically when the scanner is set to factory defaults.

From the menu, select **Device** → **Configuration Wizard**... (or press **F4**) to activate the wizard.

The configuration wizard appears, starting at its first stage. During wizard navigation, the following options are available at any stage:
- Click **Previous** to switch to previous stage.
- Click **Cancel** to exit the wizard without completion. No parameter will be modified or saved to the scanner.
- Click **Next** to continue to the next stage.
- **Upload All** available only for Senior Technician

**Step 1/5: Set System Parameters**

Step 1 allows choosing device name and preferred measurement units.

1. Set the device tag name/identity in the **Tag Name** field. This name is displayed on the scanner screen and in the software window title once the device is connected. The tag name field is limited to 16 characters.
2. Choose the preferred distance measurement unit in the **Distance Unit** field. The available options are: meters, centimeters, millimeters, feet and inches.
3. Choose the preferred temperature measurement units in the **Temperature Unit** field. The available options are: Celsius and Fahrenheit.
4. Click **Next**.
Step 1/5: Set System Parameters

Step 2/5: Set Vessel Parameters

Step 2 allows identifying the vessel geometry basic shapes for exact volume analysis. Geometry of the vessel major parts (top, center and bottom) can be chosen and their dimensions can be defined.

1. Choose the proper shape for the vessel top from the Top Shape field. The options are: Flat, Cylinder, Dome, or Pyramid. Set the dimensions:
   - For a cone shape, set the height and the top diameter of the cone.
   - For a dome shape, set the radius of the dome.
   - For a pyramid shape, set the top section height, width and length of the vessel top at the X and Y directions.

2. Choose the proper shape for the vessel center from the Center Shape field. The options are: Cylinder or Cube. Set the dimensions:
   - For a cylinder shape, set the height and the diameter.
   - For a cubic shape, set the height, width and length of the vessel according to the X and Y axis, respectively.

3. Choose the proper shape for the vessel bottom section from the Bottom Shape field. The options are: Flat, Cone, Dome, or Pyramid. Set the dimensions:
   - For a cone shape, set the height and the bottom diameter of the vessel bottom section.
   - For a dome shape, set the dome height.
For a pyramid shape, set the height, width and length of the vessel bottom section at the X and Y directions.

If the vessel shape is asymmetrical, for both cone and pyramid shapes, it is possible to set the bottom center as an offset from the entire shape center. The X Position and Y Position are the offset of the bottom section from the center.

4 Click Next.

Step 2/5: Set Vessel Parameters

Step 3/5: Set the Device Position

This stage allows specifying the exact location of the scanner on the vessel top.

1 Set the device location according to the previously defined top vessel shape using one of the following methods.

- Drag the device on the screen, or:
- Enter the X and Y coordinates in Device Position fields at the top right corner.
- Set the Offset from Vessel Top when the scanner is not installed on the vessel ceiling but a standpipe or socket are in use or the scanner is lowered using neck extension, or a head-body separation kit.
- The offset is referred to the top part of the antenna body, not necessarily to the flange.

NOTE: The device Z position is being calculated automatically.

NOTE: The Side View image will display the changes of the scanner if the offset parameter is used and will show the scanner when mounted on
the ceiling slope or a horizontal rooftop.

2. **Click Next**

**Step 3/5: Set the Device Position**

This stage configures the vessel filling points. Up to 10 filling points may be defined. The following figure describes a schematic top view of the vessel and the filling point locations.

1. **Set the filling points using one of the following methods:**
   - Bring the cursor to the desired location over the vessel top shape and left-click the mouse to set the filling point, or:
   - Press **Add** and enter the X, Y and Z coordinates in the Filling Points table and press **Enter** button, press **Enter** after every number entered.

   To edit a field: double click the field, enter the required value and press **Enter**.

   To delete a filling point, mark the corresponding row and click **Delete**.

   To delete the full list of filling points, click **Clear All**.

2. **Click Next.**
Step 4/5: Set the Filling Points

This stage allows configuration of the vessel full and empty calibration levels. The following figure contains a schematic view of the vessel with the emptying point locations.

1. Set the distance from the flange (or top of the horns body) to the material level of 100% (see figure below) using the **Full Calibration** field.
2. Set the distance from the flange to the material level of 0% (see figure below), using the **Empty Calibration** field.
3. **Distance from flange to bottom** – represents the maximum distance between the flange (or top of the horns body) to the vessel bottom. Double clicking this field sets the empty calibration level with the same value.
4. Press **OK**.
Step 5/5: Set Process Details

If parameters were modified during the wizard process, the following box appears (figure to the right) offering an option to upload all parameters to the device.

- Click **Yes** to upload parameters to the scanner and to exit the wizard.
- Click **No** to close the wizard without uploading parameters to the scanner.
- Click **Cancel** to close the window and stay in the wizard.

**NOTE:** The full and empty calibration levels in the MVL System must be set to the same level for all vessels. Use the following formula to calculate the proper levels: \( Z_1 - FC_1 = Z_2 - FC_2 \), where \( Z_1 \) and \( Z_2 \) are the Z position of the scanner as set in step 3, \( FC_1 \) and \( FC_2 \) are the full calibration levels in each device. In this case, both \( Z_1 \) and \( Z_2 \) are known. Set \( FC_1 \) to a fixed number and calculate the value of \( FC_2 \) that need to be entered in the second scanner. See schematic drawing on the next page.

The same applies for the empty calibration levels: \( Z_1 - EC_1 = Z_2 - EC_2 \). EC stands for Empty Calibration level – measured from the scanner’s horns.
7.3 Additional Functions in 3DLevelManager

Firmware update
Upload a new firmware to the 3DLevelScanner. For detailed instructions, refer to page 55: Tools Menu.

Model Upgrade
3DLevelScanner model upgrading/downgrading is not available for MVL model.

Continuous Grades
This feature allows running the grades analysis continuously for later viewing of the changes in material and scanner behavior over time, for an in-depth analysis. This feature is also possible with all scanners connected in a multi-drop connection type. Use the Every field to set the pause interval between two scans and check the Enable Multidrop box. For more details, refer to page 55: Tools Menu.

Advanced Configuration Parameters
Following the completion of the configuration wizard of the 3DLevelScanner, open the advanced parameters window (press Device ➔ Advanced Parameters…) in order to set general parameters such as Material Slope and Dumping Time. Other parameters may be configured and fine adjustments can be done at a later stage. Refer to page 55: Tools Menu for detailed instructions and descriptions.

Grades Analysis
Once configuration is done, a Grades analysis should be performed in order to view the returned echoes from the material surface and to use it to adjust the scanner. Refer to page 55: Tools Menu for detailed instructions.

False Echo Mapping
In vessel installations with high sockets, struts or agitators, corrugations, as well as with material buildup and welded joints on the vessel walls, reflection interference may result in erroneous measurements. The False echo mapping feature detects and marks these false
echoes to be ignored during volume measurement. It is recommended to generate the false echo mapping when the vessel is empty for detection of all potential interfering reflections.

The false echo mapping feature is located under the Tools menu, and allows automatic scanning (enter a range to scan), manual scan (enter the range and threshold) and to reset all false echo mapping (including Auto False Echoes). Refer to page 55: Tools Menu for more details.

**Log Viewer**

The 3DLevelManager collects all data received from the scanner and stores it on the local computer hard drive. Selecting View → Log File... or pressing CTRL+W opens the logs view application. When a scanner is connected, the log graph starts building from the connection point. Browsing old logs can be done by pressing the browse button [...] and selecting the folder for viewing the log file contents.

The logs are saved in HTML format and are stored in a folder labeled with the connection time and date. For more information, refer to page 36: File menu.

**3D Image Profile**

The 3DLevelManager is equipped with a highly useful feature of generating and displaying a 3-dimensional, graphical representation of the visual mapping contour of the stored material as scanned by the 3DLevelScanner MV and MVL models. For more information, refer to page 51: View Menu. Note that viewing a single MVL type scanner will not be accurate and it is recommended to view the complete system image in the 3DVision application.

**View Multiple Logs - Log Viewer**

When connecting to the scanner or to scanners connected in multi-drop, a new folder is created containing all data from the scanners. The 3DLevelManager allows viewing of multiple log folders at once. For viewing multiple logs, create a specific folder with a unique name, and copy all required folders to the new folder. Open the Log Viewer (Ctrl+W), press the browse button [...] in the log viewer application and browse for that folder. When selecting the folder, the log viewer starts displaying the logs data. Wait until loading is complete.

**Historic Log**

For retrieving and viewing stored logs data from the scanner, select View → Historic Log.

The Historic log contains historical scanner activity data. The Historic log feature must be activated in order to view its contents. For activating the Historic log, set in the Advanced Parameters window the sampling period between two stored logs. The options vary from 1 minute to 60 minutes. Allow storing the log between 3 days to 180 days accordingly.

In the Historic log window, select Log and press Start, or select log, Partial log and set the number of days and hours calculated back from the current time. Performing partial log may be faster than trying to receive all data.

**Play a 3-Dimensional Movie**

The Visual Mapping feature allows building and viewing a movie based on the generated 3D representations as frames. When activated, a player window opens for selecting the desired log folder for generating the movie.
The 3D movie feature works only with MV or MVL scanner model logs, refer to page 51: View Menu for more details.

7.4 3DLevelManager Software Menus

File menu

Load parameters for Browsing…
Opens a saved parameters file (.CFG file) for browsing only. Uploading to the scanner is not allowed. Shortcut key: Ctrl+B.

Load Parameters to Device…
Opens saved parameters file for uploading to a connected scanner and for browsing. Shortcut key: Ctrl+D.

Save Configuration…
Saves all parameters (Basic settings, Safety settings, Linearization, Extended calibration, Output, Display, System Parameters, 3D Mapping and Advanced parameters) to a CFG type file. You can choose the location and file name to be saved. Shortcut key: Ctrl+S

Browse to Local Folder…
Open the local 3DLevelManager Application Data folder. This folder includes different log files and grade analysis files.

Generate a New Log File
Stops storing data on current log file and generates new file with an updated time and date stamp. A new log folder is created under the software installation directory, for storing log files with all data from the scanner. At least 2MB/day free hard drive space should be reserved for the logging activity in normal operation connection (not Verbose).

Exit
Exits the 3DLevelManager software. Shortcut key: Ctrl+X

Communications Menu

This menu allows connecting and disconnecting to the device as well as polling address selection, communications quality test and log file / history viewing.

Connect… (Ctrl+M)
Opens the connection box (shown to the right) which allows setting the required link and communication properties and to establish a data connection between the software and the scanner.

In Standard mode, RS-485 or TCP/IP can be selected. When changing to a higher operation mode, more options become available. This section describes all options.

In the Connection Method field, select the communications interface used for connecting the scanner to the computer and the software. The available options are:

- RS485: Connection over RS-485 bus.
- Select the serial COM Port number the RS-485 Converter is connected to in the computer, and enter the scanner polling address, or set to multiple (recommended during MVL system configuration)
- Click Connect.

TCP/IP: The scanner is connected via a TCP/IP network to an RS-485 connection.
- Select the site name the site name at the box shown below.
- Select the scanner polling address.
- Set the Server IP address and IP port number in the right pane. Server IP is the device converting RS-485 to TCP/IP.
- Click Connect.
NOTE: All communication options other than RS-485 and TCP/IP are not to be used in MVL system.

- **Polling Address:** Enter the scanner polling address when connected via daisy-chain connection (RS-485 Multi-drop). Address range: [00 to 63 or Multiple]. Each scanner must have its own, unique address.

**Disconnect**
Disconnects communication to the device.

**Polling Address Selection...**
Available when the 3DLevelManager is connected to scanners in multi-drop. Use the dialog box (see figure below) to select polling addresses of multiple 3DLevelScanner scanners to be monitored using the Multi-drop connection.

Check the check-boxes with the polling address per each scanner to be monitored. Log files will accumulate data for all checked scanners.

- **Normal Scanning** scans all selected scanners. This is the default option and it should not be changed in normal operation.
- **Slow Scanning** adds a delay between polling of each scanner. This option can be used when communication speed is low
- **Pause Scanning** stops communicating with other scanners and stays with current scanner to retrieve information, until setting back to normal or slow scanning mode.

NOTE: The scanning option parameter selection on top-right exists only on older software versions, and should not be modified.
Communication Quality Test
Analyzes the connection quality of the RS-485 cable connected between the computer and the scanner. If packets are not answered or received with errors, the cable must be checked for existence of proper resistors on both sides and verified to be of shielded and twisted-pair type.
An example for a good test result: average delay of 97msec (very low), no lost packets and no errors received.
- Click Restart Test to restart testing. The test will cycle through until terminated.
- Click Close to terminate the test and close the window.

Communication Log File...
The Communications Log File contains logged data corresponding to the communications between the software and the scanner connected to it. Selecting this option opens the file in an Internet browser window. The file format is HTML and it might be required for tech support use.

Communication History...
The Communications History contains logged data corresponding to the communications events between the software and the scanner connected to it. Selecting this option opens the file in an Internet browser window. The file format is HTML and it might be required for tech support use.

Device Menu
This menu allows accessing to advanced configuration options. Some of the menu options are disabled in Viewer mode, and become available under Technician mode.

Configuration Wizard… (F4)
The configuration wizard provides a wizard-based, graphical-aided tool for configuring a connected 3DLevelScanner. At the first run after software installation or following a new scanner connection, all wizard steps must be followed and all parameters should be configured according to the Installation Preparation Form (IPF) filled prior to the installation and approved by the APM Customer Support or by your local distributor.
Refer to page 28: *Configuration and Analysis* for a detailed description of the configuration wizard.

**Advanced Parameters… (F5)**

Opens the 'Advanced Parameters' box, where the algorithm parameters can be adjusted. This window is accessible under Technician and Senior Technician modes only. The various fields can be downloaded or uploaded from/to the scanner. Any modified settings can be discarded using the **Cancel** button at the bottom.

When connecting to a 3DLevelScanner with earlier firmware version of 2.x.x, the Advanced Parameters window looks different and visible parameters may be visible.

In Technician Mode, the user has limited access to the parameters.

- **Output Dumping Time**: Sets the history dump window time of the scanner. This parameter increases stability and improves the SNR. Default value: 300 seconds, minimum value: 60 seconds.
- **Steepest Material Slope**: Set the maximum material slope. The scanner verifies all echoes for not exceeding the slope. Default: 35°. Recommended setting: between 30° to 45°.

- **Top Dead Band** [Discard/Don’t Discard]: To be used only when echoes canceling with a mapping range for short distances is not possible. The unit discards all echoes up to the full calibration. Default: Don’t Discard.

- **Discard**: The sensor scans material only at a distance larger than full calibration distance.

- **Don’t Discard**: Distances smaller than full calibration distance are scanned as well. If measured distance to the content is smaller than full calibration, the full calibration distance is presented.

- **Historic Log Sampling Period**: Sets the interval between measurements saved in the local memory. By default, the scanner does not store the log. The settings are ranged between 1 to 60 minutes. If the scanner has been reset due to powering off or via the software, this parameter resets to its default value and the log will not proceed with data accumulation. When connecting to a scanner of an older FW version, the following advanced parameters are available. The following descriptions refer to parameters which were not mentioned above.

- **User False Echo**: Enable/Disable (default: enabled) Sets the algorithm to consider the false echo mapping done manually by the user. Setting this parameter to Disable will cause the scanner to ignore the manual false echoes.

- **Auto False Echo**: Enable/Disable (default: enabled) Sets the algorithm to automatically calculate false echo levels. Setting this parameter to Disable will stop the scanner from continuously calculating the false echo levels and will keep the last image of false echoes, if the false echoes are reset manually, the level will be set to 0.

- **Max Capacity** [tons]: The total capacity of material within the vessel.

- **Max Emptying Rate** [tons/hour]: The maximum emptying rate in tons per hour.

- **Max Filling Rate** [tons/hour]: The maximum filling rate in tons per hour.
In Senior Technician mode, additional fields are added:

- **Mechanics Type** [I/II]: Sets the type of the scanner. The options are I or II. It is extremely important to set the proper mechanics type in order to avoid wrong calculations.

- **CFAR Sensitivity**: Constant False Alarm Rate detection automatic threshold algorithm. Setting the sensitivity adds gain to the CFAR threshold (default: 9db). Adding 6db doubles the gain. This is an adaptive and robust algorithm for the detection of targets in a noisy environment.

- **Minimal SNR** [dB]: The lowest SNR threshold. Below this level, the sensor does not measure and the reading remains unchanged. Default: 13dB.

- **Restrain coefficient** [%]: Sets the level of preference of echoes from shorter distances over echoes from farther distances. 100% = no preference of closer echoes. 0% = total preference of the first echo. Default: 10% in FW lower than 3.0.0, 12% in new FW.

- **Side Margins** [m/ft]: Allows tolerance in echo recognition to the sides of the vessel (see figure).
  Used for creating a tolerance in case of unknown vessel width/diameter, and when a tolerance is required for detecting points from the sides of the vessel. Echo within the tolerance/margin range is transformed to the side of the vessel on the X-Y plane and will not be eliminated in calculation. Default: 1m (3.28 ft.).

- **Bottom Margins** [m/ft]: Allows adding a tolerance in echo recognition from the bottom shape (but not flat) (see figure).
This is used for creating a tolerance in the case of unknown vessel dimensions, and when a tolerance is required for detecting points from the bottom of the vessel. Default: 1m (3.28 ft.).

- **User False Echo Sensitivity**: Refers to the Manual False Echo mapping done by the user. Defines the minimum extra gain required to distinguish between real echoes and mapped false echoes. If false echoes prevent the device from tracking the true level, sensitivity should be decreased. If false echoes are not ignored, increase the sensitivity. Default: 1.2.

- **Auto False Echo Sensitivity**: Refers to the auto false echo calculation done by the algorithm. The minimum extra gain is required to distinguish between real echoes and mapped false echoes. If false echoes prevent the device from tracking the true level, decrease the sensitivity. If false echoes are not ignored, increase the sensitivity. Default: 1.2.
Beams Activation tab allows setting the beams for manual selection or automatic selection by the algorithm. By default, the beams are selected automatically and some beams will be removed depending on silo dimensions.

**High, Med and Low** Frequency beams represent three separate transmissions emitting a signal from all three antennas simultaneously.

**30, 90, 150, 210, 270 and 330** degrees directions represent 6 separate directional transmissions for the algorithm to make better consideration of the returned echoes. All 6 transmissions are transmitted in the Med frequency.

When removing the check box from the **Auto Beams Selection** box, beams can be enabled or disabled. Setting one or two of the directional beams only is not possible. At least three consecutive beams must be selected. For example: Direction 30, Direction 330 and Direction 270.

The conditions to automatic beams selection are:

i. If Z position is bigger than 2.5 times the diameter and also Z position is smaller than 30m (98.425ft) – only Beams **High** and **Med** will be activated

ii. If vessel diameter (or one of the horizontal dimensions in case of a cube) is less than 8m (26.25ft) or if the Z position is less than 4m (13.125ft) then Beam **Low** will be disabled

iii. If vessel diameter (or one of the horizontal dimensions in case of a cube) is less than 4m (12.125ft) then only Beam **High** is activated

**Automatic Beams Range**: enabled by default. This option sets an automatic range limitation to the echoes selection. This limitation is shown in the Grades analysis window as the vertical orange line.
Download All: Downloads all parameters from the scanner.

NOTE: Three options are available to access all parameters downloading: using the Main Screen, using the Device menu and using this Advanced Parameters window.

Upload All: Uploads all parameters to the scanner.

NOTE: Four ways are available to access all parameters uploading: using the Main Screen, using the Device menu, using this Advanced Parameters window and using the last step of the wizard.

Cancel: Closes the Advanced Parameters windows without uploading/downloading from/to the scanner.

Current Output Settings... (F6)
The current settings window (see figure below) is designed to control the 4-20mA output signal. The following two functions are available:

Simulation: Allows current simulation of Volume (%), or Current (mA). This feature is useful for synchronizing the PLC and verifying identical read values for both scanner and the PLC. When the simulation is on, a red blinking signal appears, indicating: Simulation is Active.

Current Output Mode: Allows setting the output to send the standard 4-20mA signal or optionally to send a reverse signal: 20-4mA. The last option sets the scanner to output a fixed value.

NOTE: Notice the simulation indicator which is shown when the simulation is active.
Output Settings… (F7)
The Output settings option defines the displayed calculation on the software and the way the 4-20mA output behaves. It allows selecting Volume (default), Mass, Level or Distance output (see figure below).

- **Volume:**
  - **Calculation Using Silo Structure** – calculates the volume based on silo structure as defined in the configuration wizard. The displayed units can be selected to be available to the user.

- **Calculation Using Level-Volume Table** – allows setting a linearization table based on level-to-volume conversion.
● **Calculation Using Distance-Volume Table** – allows setting a linearization table based on distance-to-volume conversion.

- **Mass:**
  - **Calculation Using Fixed Bulk density** – calculation of mass based on the silo structure and volume calculation at a certain level. The bulk density value can be entered in Tons/M³ or lbs/ft³ units.
- **Calculation Using Level-Mass Table** – conversion of the calculated average level directly into mass
Level-Mass Linearization table

- **Calculation Using Distance-Mass Table** – conversion of the calculated average distance directly into mass.
- **Calculation Using Level-Variable Bulk Density Table** – conversion of the calculated average level into volume based on silo structure, multiplied by the bulk density value at that level to convert into mass.
**Calculation Using Distance-Variable Bulk Density Table** – conversion of the calculated average distance into volume, based on silo structure and multiplied by the bulk density value at that distance, to convert into mass.

**Level** – Output the Level of material
- **Distance** – Output distance to material

- **Output Settings windows buttons functionality:**
  - **Upload** – uploads all information to the scanner. If parameters were not properly configured, an alert message pops up describing the problem.
  - **Open Table** – if available, the table can be edited according to the requirements.
  - **Cancel** – discards all changes and closes the window.
  - **OK** – keeps settings and advises uploading the changes to the scanner.

- **Table buttons and functionality:**
  - **OK** – saves the configuration. Requires uploading from output settings window.
  - **Cancel** – discards all changes and closes the table window.
  - **Apply** – uploads changes to the scanner.
  - **Show Vessel** – enlarges the table window and displays the silo structure and level indication when a table row is selected.

- **Table operations:**
  - Right clicking the row number allows adding a row above, deleting a row, clearing rows above, clearing a row or clearing rows below.
  - Right clicking the # on the top left of the table allows clearing the entire table
  - Right clicking the editable column allows clearing that column

**Upload All (F2)**
Uploads all parameters to the scanner.

**Download All (F3)**
Downloads all parameters from the scanner.

**Device reset**
Allows selecting a reset option:
- **Restart Scanner**: Sends a restart command to the scanner. The internal DSP will boot up and start building the auto false echoes and dumping values. The initializing
process takes about 30 seconds. Upon initialization, the scanner will perform a new search for the correct measurement.

- **Reset to Factory Defaults**: Resets system parameters to their default factory settings and all the 3DLevelScanner parameters. All scanner parameters must be re-defined following this operation. Output Dumping Time and Steepest Material Slope will not reset to their factory defaults.

- **Reset Advanced Parameters**: Reset all advanced parameters (available only with firmware versions 3.x.x).

**View Menu**

**3D Image**

Generates and displays a 3-Dimensional graphical representation of the visual mapping contour as scanned by the 3DLevelScanner MV or MVL (see figure below).

The legend scale to the right side displays the measured level.

- To rotate the 3D image, press and hold the mouse left key and drag over the image at the desired rotation direction.

- The application generates 3D mapping frames depending on the connection rate. For watching the animation, click **Watch Log**. A new 3D image and a browse window opens. Select the desired log folder (located under the **Logs** folder). Use the video controls to play, stop, move backward or forward or scroll along the time line. The interval (msec) sets the frame time interval. The minimum value is 1msec.

- For switching between a zoomed-out view of the silo and a zoomed-in view of the material surface, click the top right button or double-clicking the 3D image itself.
Right-click the mouse to open the additional features menu:

- **Show legend**: Displays the level scale on top right corner.
- **Show Material Surface Only**: Displays the surface of material only.
- **Show Vessel Geometry Only**: Displays the vessel geometry without material.
- **Show Device, Fill, Empty points**: Displays the device, filling and emptying points relative to the vessel geometry.
- **Material Color**: Allows choosing a desired material color.
- **Show Axes**: Displays the x-y-z axes.
- **Activate Pan Mode**: Switches from image rotation to panning.
- **Save Image As**: Performs a screen capture of the entire window.
- **Misc**: Opens a sub-menu with the following options:
  - **Show Silo Dimensions Wall**: Displays a grid with dimensions, same as with the zoomed in image.
  - **Draw Silo Grid (Wireframe)**: Displays a wireframe over the material surface.
  - **Show Solid Material Color**: Displays the material in a solid color.
  - **Fill Bounds with Material**: Shows the complete material around the surface, or the surface only.
  - **Hide Top Shape**: Hides the top part of the vessel (if not flat).
  - **3D Algorithm Accuracy**: Controls the number of points in the image. Available options are: Normal, Good and Best. Default option: Normal. Changing the option is not recommended. Such change consumes most graphic card resources.
- **View**: Opens a sub-menu with different viewing angle options.

**3D Movie**

The Visual Mapping feature allows building and viewing a movie based on the generated 3D representations as frames. When activated, a player window opens for selecting the desired logs folder for generating the movie.

The 3D movie feature works only with MV or MVL scanner model logs.

**Grades FW 2.x.x Logs**

Allow viewing previous grades analysis window conducted on scanners with firmware version 2.x.x.
Grades FW 3.x.x Logs...
Allow viewing previous grades analysis window conducted on scanners with FW version 3.x.x.

Measurement Logs (Ctrl+W)
Loads a log file and displays graph presentation (see figure below).
The Log option displays charts for Distance (m/ft), Volume (%), SNR (dB) and Temperature (°C/°F) over a time line as shown. Log files are saved as the connection is established. The files are saved in a local folder.

For viewing older log files, press the [...] browse button. A browsing window opens, showing the Logs folder for choosing a different log file. The file names include the date and time of the connection.

![Log File graph representation](image)

In Multiple Mode, the software monitors all the scanners selected in the Polling Address Selection (refer to page 38). For viewing a different scanner log file, select the scanner Polling Address from the drop-down list at the top-right corner.

Use the Preference menu for displaying logs in different distance units (m, cm, mm, ft. and inch), different temperature units (Celsius, Fahrenheit), different time zone (hour difference) and different regional settings (using dots or commas as digit separators).

### Working with the Graphs

Zoom-in, zoom-out and pan options are available for all charts created by the 3DLevelManager: Grades Analysis, Log and Historic log.

- **Zoom-In**: Choose a rectangular area you wish to zoom in and place the mouse cursor on the top left corner of it. Left click the mouse and drag it to the bottom right corner of the required area, making sure not to release the mouse button until the entire required area is selected.

- **Zoom-Out**: Place the cursor of the mouse inside the graph, left click the mouse and move it from bottom right to top left and release the mouse button.
Pan: Right click the mouse button and hold it inside the graph area. Moving the mouse pans the graph to the sides.

Back to default view: In the Grades Analysis window, double clicking the graph will pop up a window requesting a confirmation for data reloading.

Historic Log…
The scanner allows storing logs in its local memory. Use the Historic log settings in the Advanced Parameters feature to enable this option. To view the log from the scanner memory, select the Historic Log… option.

When selecting the Historic log, a box appears asking for selection of the required log time to be retrieved from the scanner. Once download is complete, a log viewer window opens displaying the logs. The log data is then saved under the Historic log folder.

Note: This option allows choosing a 3D Log option which creates a 3-Dimensional representation of the log. This option is not available under Technician Mode.

Tools Menu

Analyze…
The Analyze tool (see figure to the right) allows a selection of different signal types downloaded from the scanner at a preferred time resolution and generates a chart-type report for each scan. On choosing this menu option, the following box appears:

- Select All Grades Info or Grades or False Echoes to analyze the scanner behavior in the vessel.

- Once the desired options are checked, click Start to begin the analysis. The Analyze tool will then start downloading the signals from the scanner. This stage takes a few seconds or minutes to complete, depending on the communication speed. Once completed, the analysis results window appears.

- Click Cancel to stop the download.

- Click Close to close the Analyze… window.

- Click Load From Files and select the file from the appropriate folder for uploading a certain signal (channels, grades, or false echoes).
- **All Grades Info:** Checking this option causes the analyze tool to download the Grades, Grades Threshold (controlled by an automatic algorithm), False Echoes and Auto False Echoes. The files are saved under a separate folder named with the tag name, date and time. Note that when checking this option, the rest of the options cannot be selected.

- **Grades:** Checking this option causes the analyze tool to download all the echoes received by the scanner (energy values returned from each object in the vessel). The file is saved under a separate folder, named with the tag name, date and time.

- **False Echoes:** Checking this option causes the analyze tool to download all false echoes mapped under the False Echoes Mapping. This reveals the strength of each false echo at each distance. The file is saved under a separate folder, named with the tag name, date and time.

- **Continuous Grades:** This feature allows running the grades analysis continuously for later viewing of the changes in material and scanner behavior over time for an in-depth analysis. The Continuous Grades feature can also be used with all scanners connected in multi-drop connection. Use the Every field for setting the pause interval between two scans. The minimum value is 3 minutes from scan ending to a new scan beginning point.

- **Channels / Noise:** Checking this option causes the Analyze tool to download raw information received in the transducers. In the Channels option, enter the maximum scanning range in the Max Range field. All files are saved under a separate folder, named with the tag name, date and time.

The Noise option is to be used only when an BinMaster Technical Support representative requires this operation. This feature is intended for engineering use only.

The grades analysis charts on the next page represent a single beam analysis and all-beams analysis views respectively.

The X axis represents the distance to the returned echo from the device top of body.

The Y axis represents a grade parameter assigned to each echo by the algorithm.

The echo signals for the different beams are presented with lines of different colors. Unchecking a beam/feature at the legend box to the right hides the corresponding beam or characteristic.
False Echo Mapping
Allows mapping false echoes according to the grades analysis (and based on them).
- **Scan** – Automatic false echo mapping between the set ranges (From/To)
- **Manual Scan** – sets a constant level at the defined threshold between the From/To distances
- **Reset All False Echoes** – delete all false echoes done by the Auto False Echo algorithm and done in the false echo mapping created by the user.
- Press **Start Scanning** (or Reset Mapping) to start the calculation.

Update Firmware
Uploads a new firmware to the device electronic card.
- Click the [...] browse button to select the firmware file (*.ldr) to upload to the device.
- Click **Start Update** to upload the file to the device.
- Click **Cancel Update** to stop the update process.
- Click **Close** to close the window.

**IMPORTANT:** When using software version 3.0.0 and above and upgrading to FW 3.0.8 and above, it is not necessary to reset the device to factory defaults since all settings are done automatically.

Downgrading a scanner firmware from version 3.0.0 and above to older versions such as 2.9.843 is not recommended. On such downgrading, the scanner will return to its factory defaults and an upgrade to the original version will be necessary. Contact BinMaster technical support when facing such requirement.
Upgrade Model (Not relevant for Multi Scanner system)
Upgrades or downgrades between S, M and MV versions.

- Select the relevant type to be upgraded to.
- Click OK.
- A password is required for upgrading to a higher type (M/MV). The password will be supplied by BinMaster. Copy the password from the text file (license number) into the empty field in the dialog box.

Note: Once the upgrade process is complete, the device will automatically reset and initialize itself.

Operating Mode

- **Standard Mode**: In this mode, parameter modifications are disabled. Switching from Standard mode to other modes requires a password.
- **Technician Mode**: In this mode, basic parameter modifications are enabled.
- **Senior Technician Mode**: In this mode, advanced parameter modifications are enabled.
- **Debug Mode**: Development mode, access allowed to BinMaster team.

Help Menu
The Help menu consist of two functions:

- **Operation Manual** – Opens the 3DLevelManager Operating Instructions
- **About (F1)** – Opens the about window with the version details.
8 System Monitoring using 3DVision

8.1 Client-Server Connection

The MVL Controller is provided with a pre-installed 3DVision server and client. Installation of the 3DVision Client should be done on any required computer on the network. When starting the 3DVision Client for the first time, the system will first ask for details required for establishing connection to the 3DVision Server. After a successful connection, a box pops up asking to set user name and a password. Default user level is Administrator, with a default user name: admin and password: admin.

Introduction: Client – Server architecture

The 3DVision / 3DMultiVision software uses two types of components: Server and Client. The installation wizard will allow customized installation where it is possible to install server and/or client on each computer.

The server, as the heart of the system, must be installed only once in a project. It should be installed on a computer connected to all scanners in the project, directly or remotely. The server computer should be running and connected to the scanners at all times. The server synchronizes all scanner transmissions and collected data, manages all communications with the scanners, collects and stores readings and sends configuration parameters to the scanners. The server does not have significant options for user interaction. Rather it communicates with the client stations which are the means for users to interact with the system.

The client software is the means for the user to interact with the server, and through it, with the entire system. Multiple clients can be installed on different computers for users working with the system. All configurations, project definitions, reports, log viewing and user
actions are to be done using the client software, which sends and receives the corresponding transactions to and from the server respectively.

3DVision Server Connection example

8.2 First Time Running of 3DVision

Starting 3DVision

1. Double click the '3DVision Server' icon to start the Server application. The server application may need a short period (a few seconds to about two minutes if MVL type units are included) to initialize communications with the scanners and clients. Make sure the server icon appears on the task bar as shown.

The server should remain running. Manually running the server is required only if the computer is being restarted and the server do not start automatically.

2. Double click the '3DVision Client' icon to start the Client application. The software starts and the Server Connection dialog box appears.

3. On the first connection attempt, the Server Name and Server Address fields are empty and require typing in of the relevant details. The connection information is kept and will not be required on further connections.
In the Server Name field, enter your own description for the system managed by that server.

In the Server Address field, enter the IP address of the computer running the 3DVision Server:
- If both Client and Server programs are installed and running on the same computer, enter the computer local IP address, or 'localhost'.
- If the Client program is running on a remote computer, enter the IP address of the computer running the server.

In the Server Port field, verify that the server port is set to 22222.

Click **Connect**. The application connects and a login dialog appears.

4. Enter your username and password. The default username and password are both "admin" (case sensitive).

**IMPORTANT**: Define the user names, passwords, and permission levels for the various user accounts prior to setting up projects in the system. Refer to page 89: *Tools Menu* for a detailed description. At least one user account must have the administrator permission level.

**NOTE**: For logging-in to the system directly in technician mode, enter the technician mode username and password. For further details, refer to page 89: *Tools Menu*.

Following a successful login, the software automatically opens the last project. If no project exists, a new project can be created by pressing the New Project icon in the center of the screen or by selecting File→New...
Starting a new project


2. In the Name field, enter a name for the new project. In the # Sites field, enter the number of sites the project should manage (each site may contain multiple vessels). Click Next.

**IMPORTANT:** If you are running the 3DVision application you can specify one Site and one Vessel only. An upgrade to the 3DMultiVision version is required for configuring more than one site. Contact BinMaster for purchasing a license key for upgrading to 3DMultiVision.
Type in the Site name (limited to 16 characters) and enter the number of vessels in the site and the number of scanners in each vessel. Editing a site, vessels and scanners are possible on a later stage.

Set the connection type between the 3DVision Server computer and the scanners in the site. RS-485 and TCP/IP options can be used in MVL system. In RS-485, choose the proper serial com port for the server PC connection. In TCP/IP connection type the IP Address and TCP port of the RS-485 to TCP/IP converter. Click Finish. The new project is created and the main window appears. A selector box appears on top for each vessel in the project as shown to the right.

**NOTE:** When a project includes more than a single site, each site should be individually defined with the number of vessels it includes, number of scanners per each vessel, connection method and serial COM port. Clicking Next switches to the next site. Repeat site configurations for all sites. In the next example, only a single site is defined.
The project window

The project window is built according to the project hierarchy of Sites > Vessels > Scanners.

Multiple sites can be defined in the project. Defined sites will be added and can be selected from the sites navigation bar on top. When selecting a site, its relevant information and configuration options appear at the main area, organized in two tabs: Vessels and Logs. Refer to page 71: Main Software Screen for display area descriptions.

Multiple vessels may be defined per each site. The vessels are represented by icons appearing on the vessel navigation bar. When selecting a site from the site navigation bar, the corresponding vessels are shown on the vessel navigation bar, where a vessel can be selected. Selecting a vessel causes the main view to display various types of information and configuration options related to that vessel at the main area under the vessel navigation bar, organized in different tabs: Overview, Logs and Parameters. Right-clicking a vessel icon opens a menu with different options related to that vessel. Note that left-clicking a selected vessel icon pops-up a menu with different options.

Multiple scanners may be defined under each vessel. A scanner can be selected and accessed using a drop-down list which appears on the upper-right corner below the vessel navigation bar, for the selected vessel.

NOTE: Selecting a scanner for configuration under a specific vessel can be done only by logging in under Technician mode.
Vessel Properties Configuration

The examples below show how to configure a single site with a single vessel with 2 or 4 3DLevelScanner model MVL devices.

**NOTE:** In order to configure a vessel with more than one scanner, all scanners must be of MVL type.

### Vessel Properties Configuration Process

1. Select the vessel selector box and right-click the vessel name. Select **Property...** From the drop-down menu. The Edit Base Properties box appears (see figure below). Enter the vessel name and description, and click **OK**.

   ![Edit Base Properties box](image)

2. Double click the vessel image to open the vessel measurements and details pane (see next figure). The 'Overview' tab shows the number scanners set for this vessel and their connection status.

   **NOTE:** If the selected vessel contains more than one scanner and the user logged in has Technician privileges, refer to page 81: Users Management. The 'Scanner' drop-down list appears at the top-right corner (see next figure). Select the required scanner for configuration from the dropdown list.

3. Click **Parameters** to open the Parameters tab for configuring the scanner parameters. Choose Connection Type (RS-485 or TCP/IP), Serial COM port and set the polling address.
Configure all the scanners set for the vessel by selecting them from the scanners list and entering their communications parameters.
5 Once all scanners are configured, connect to all the scanners in the vessel by right-clicking the vessel name and selecting the **Connect** option from the drop-down menu. For more options and details, refer to page 73: Vessel selection behavior.

Once a connection is established, click the site selection box on top of the screen (as shown to the right) to select a site. The vessel profile screen appears, with the results of the scanned measurements as shown below.

![Vessel Profile](image)

6 For viewing a 3-dimensional profile representation, right-click the vessel measurements figure (the bigger vessel figure when in Site view) and select **Show 3D profile**.
NOTE: For viewing a 3-dimensional profile of the product in the vessel, double-click the vessel image.
For more information regarding the 3D Profile, refer to page 84: 3-Dimensional representation.

8.3 3DVision Software Navigation

This chapter provides an overview of the various toolbars and menus as well as an overview of the projects.

Project Overview

The 3DMultiVision software allows defining different projects. Each project is organized in the following hierarchical structure:

- Top Level: the project
- Second Level: a list of sites in the project
- Third Level: a list of the vessels in the current site
- Fourth Level: a list of the scanners associated with each vessel

For example, a single project may include multiple sites (or multiple groups of vessels), where each site / group may contain multiple vessels, with one or more scanners per vessel.

The example shown below describes a single site called Manual, which includes a single vessel named Silo 306 with 2 scanners of type MVL.
Site Selection (located on center-top area of the screen): Allows navigation among defined sites. The figure to the right shows a project with 3 sites, named: Manual, Site 3, Group 52.

To edit/add or remove sites use the Edit menu (refer to page 88: Edit Menu).

The site selection also allows viewing 3-dimensional profiles for multiple vessels. Right click the vessel measurement figure and select the Show 3D profile option. A window appears, showing the 3-dimensional image. Multiple 3-dimensional profile windows can be opened at the same time; however only the yellow-framed one displays real-time parameters.

Vessel Selection: Allows navigating among vessels defined in a site. The figure to the right shows a site with 4 vessels: Silo 306, Silo 307, Silo 308 and Silo 309.

For editing, adding or removing sites use the Edit menu (refer to page 88: Edit Menu).

Scanner Selection: Use this option to set the scanner polling address, communication method and properties.
Main Screen

Main Software Screen

The major areas in the main screen are:

9  **Main menu**: Includes the software main menus: File, Action, Edit, Tools and Help.
10 **Project toolbar**: Includes various tools for project management and operations, such as project opening and saving, connection to sites and data loading.
11 **Site selection bar**: A project allows multi-site management, where each site may include multiple vessels. The selection bar allows selecting a site for monitoring and operations.
12 **Vessel selection bar**: Lists all vessels included in the site selected from the Site selection bar. Allows selecting a vessel for monitoring and various operations.
13 **Scanner selection list**: Automatically populated with all scanners included in the selected vessel. Allows selecting a scanner for monitoring and various operations.
14 **Control tabs**: Includes tabs related to the selected item (site, vessel or scanner). Each tab switches the main work area (below the tabs) according to the tab's function.
15 **Main work area**: Provides graphical and textual information and properties, different modification and control options related to the selected item (site, vessel or scanner) and according to the selected tab on top of it.
16 **Status bar**: Displays actual information related to different operations and processes, such as downloading data and connection.

Main Toolbar

The 3DMultiVision toolbar allows various project control operations.
The Toolbar

**Open:** Opens an existing project for local browsing.

**Save:** Saves the present project. Change in the existing project must be saved for the changes to take effect. In the title bar, next to the name, a (*) will appear whenever a change is made. It disappears on saving the project.

**Level/Distance Data:** Allows choosing the measurement type displayed (level or distance). Displays the measurement of material in the vessel by either Level or Distance.

- **Distance** refers to the distance of the material from the scanner. **Level** refers to the level of material measured from the bottom of the silo.

The selection applies to measurements in all viewing panes, at all view levels, for the corresponding values (min / max / average). Click the button to toggle between distance and level display.

**Connect Vessel/Scanner:** Connects the selected Vessel or the selected 3DLevelScanner device to the 3DMultiVision application.

**Disconnect Vessel/Scanner:** Disconnects the selected Vessel or the selected 3DLevelScanner device from the 3DMultiVision application.

**Load from Vessel/Scanner:** Manually download all measurements from the selected vessel or the selected 3DLevelScanner to the 3DMultiVision application. All data is automatically downloaded, from all scanners for all vessels to the server.

**Sort By:** Sorts the vessels by different groups: All, Material, Name and All Same Size.

- **All:** Displays all vessels in all sites, ordered by the 3 major sizes: large, medium and small.
- **Material:** Displays the vessels ordered by their material name.
- **Name:** Displays the vessels ordered by their names.
- **All Same Size:** All vessels are displayed at the same size.
- **Manual 4x4, 5x5, and 6x6:** Sets the order of vessels to the selected grid.
- **Manual:** Sets the grid as defined in Tools/Configuration menu.

When selecting a sorting option other than All, the site
display changes and shows the vessels in groups, arranged according to the sorting criteria, as shown in the following image:

![Sort By Name view](image)

The Manual sorting options display the vessels in different sizes, according to the selected option. The sizes are smaller and may be more convenient when managing a large site. For example, selecting **Manual 4x4** shows the vessels as follows:

![Sort By Manual](image)

Use the Tools / Configuration option to define the Manual matrix type (rows and columns) used for displaying the vessels.

**Connection status**: Indicates the client connection to the server. For more details, refer to *page 82: Alert types*.

### Vessel selection behavior

Vessels are displayed within rectangular blocks in the main area under the vessel selection bar. Each vessel is represented by a rectangle with the following items:

- The vessel image with the material stored at the selected material color and at its current level
- Stored material name and scanner model
- Empty and full levels are represented by red and orange lines respectively
Level measurements: includes current level, maximum level and minimum level data using the configured measurement units, and volume in percents

A status indicator: In the case of a failure, the indicator and the entire background of the rectangle become red.

Double-clicking the vessel rectangle replaces the display and brings up the detailed vessel tabs in the main area, with the **Overview** tab selected.

Left clicking the vessel rectangle opens a menu for quick-access to the following features:

- **Show 3D Profile**: Pops-up a 3-dimensional profile window.
- **Material Selection**: Opens the material management box which allows choosing a different stored material for that vessel.
- **Properties**: Brings up the Material property box, which allows choosing the visible material properties in the representing rectangle and the alert types to be used for that vessel. Refer to page 82: **Parameters and Alerts** for further details regarding alerts.

A single mouse left-click selects the vessel. The selected rectangle becomes outlined with a yellow frame, and the corresponding vessel icon in the vessel navigation bar is selected.

When right-clicking a selected vessel, the menu opens with a different set of options. The following options are added:

- **Connect / Disconnect**: connect or disconnect communication from the selected vessel scanners to the server.
- **Load from Vessel**: loads data from the vessel scanners and updates the displayed status and parameters.
- **Edit**: allows adding a new scanner to the selected vessel or deleting the entire vessel.
- **Generate report - Download from Server**: Opens a date/time selection box for selecting report date and time, downloads the corresponding historical data from the server and opens a file browser box for choosing the report file location.

The report file is being created in PDF format, and includes the date, time, project and vessel details and volume / mass and alert parameters for the selected date and time. The report also includes 3-dimensional representations of the corresponding vessel.

- **Generate report – From local folder**: opens a folder browsing box for choosing the folder where the related data is stored. Creates a report as described above, but per data stored locally.
Vessel Pane

The Vessel Pane includes different monitoring options and allows performing basic vessel operations as shown below.

Overview tab

Selecting the Overview tab switches the main area below to display two panes. The left pane includes the vessel connection information, alerts, measurements and indications related to the selected vessel:

- Vessel name, connection status of the vessel and selected scanners.
- Alerts, if they exist.
- Scanner names, versions and communication details
- Minimum Level/Distance.
- Maximum Level/Distance.
- Volume (%).
- Mass (if density is defined).
- Temperature.
- SNR.
- Scanner Output Current.
- A graphical representation of the vessel, including the vessel shape, maximum and minimum levels and a connection status indicator.
- Material button: allows choosing the type of material contained in the vessel. Pressing the button brings up the Material selection window which allows managing of the materials with their names and colors, where the material can be chosen out of a pre-defined list of materials and their representing colors.
When a scanner is selected from the scanners list, its information is also displayed:

- Scanner Name.
- Connection Type.
- COM Port.
- Polling Address.
- S/N - Serial Number of the electronic card.
- Hardware Version.
- Firmware Version.
- Scanner Type - Type of 3DLevelScanner.

Logs tab
The Logs tab provides a chart representation of historical measurements data, and allows different manipulations for chart inspection. For further details, refer to page 86: Log views.

Parameters tab
Selecting the Parameters tab switches the main area below to display vessel shape parameters: top shape, center shape and bottom shape, and their dimensions.

Scanner Parameters
When a scanner is selected, the scanner parameters are displayed. Connection settings must be defined for each scanner in the project.

For each scanner in the vessel, the Parameters tab allows defining the following:

- Connection Types:
  - RS-485
  - TCP/IP
- Configuration details:
  - Serial Port
- Polling Address
For example: In the figure below, the connection to the scanner is set to RS-485 type connection; serial COM Port 4 and polling address 00.

For a more detailed explanation regarding various connection methods to a 3DLevelScanner, refer to page 20: Connection Methods.

8.4 Advanced Tools
This chapter describes several useful tools for configuration, system administration and reports handling.

Advanced Reporting Features
The 3DMultiVision software offers a wide range of report types of different levels and content.
In the main menu, select Tools → Reports to access the report options.

Report configuration
From the Reports menu, select the Configure… option. The Report Configuration window appears (see Report Configuration window below). The Report Configuration window allows the following options:

- Setting report creation time:
  Multiple reports can be generated at different times during the day. Adding a creation time is done by setting the required time on top-right time entry field, and clicking Add. The new creation time will be added to the list at the top left.
  Clicking the Set Default button will set the selected creation time in the list to be the default value for further configurations.
The **Every Hour** button automatically generates a list of creation times every hour during the day.

The **Delete** button deletes the currently selected creation time from the list. The **Delete All** button clears the list.

- Setting report repeating generation options:
  Report creation may repeat itself with the following options:
  - **Daily**: The report will be generated every day at the creation time set above.
  - **Weekly**: The report will be generated once a week at the creation time set above and the Week-Start Day selected.
  - **Monthly**: The report will be generated once a month only at the creation time set above and the first week-start Day selected.

- Setting data types to be included in the reports
  The report will include data types combined of the checked options: Distance, Level, Volume [%], Volume (absolute) and Mass.

- Selecting report related folders and file formats
  Each report can be included in its own directory, which is created automatically. To enable automatic directory creation, check the Report Directory Creation checkbox. Reports saved on the server computer will be stored in the directory set in the **Server Reports Output Directory** field. To change directory, click the [...] button and chose a different directory from the browse box that opened (executed on the server computer).

  The software allows choosing the application to open stored report files, such as Excel. For choosing a different application, click the [...] button and select the desired application. The selected application must support the Excel (.xls) file format.

  Click the **Save** button to save the updated report settings.

  Click **Cancel** to exit and discard any changes made.
Hardware Inventory Table
This system allows creation of a special report called Hardware Inventory Table, listing the following:
- All sites included in the project with their names, descriptions and server names.
- For each site, the included vessels are listed with their names.
- For each vessel, the scanners related to that vessel are listed under it.

The table contains the following properties per the included items: vessel, serial number, scanners hardware and firmware versions, polling address, scanner model and connection type for each scanner.

To activate the Server Inventory, select Tools → Reports → Inventory Summary Table. The table appears as shown below.

The Refresh button can be pressed any time to view updated contents.
Measurement Summary Table
Another special report is the Measurement Summary Table, which lists the Volume (absolute), Volume %, Mass and Alerts for all vessels on all sites, grouped by site. The table lists the measurement units reported by the scanners.
To activate the Measurement Summary, select Tools → Reports → Measurement Summary Table. The table appears (see figure below).
The data displayed can be updated anytime by pressing the Refresh button.

![Inventory Summary table](image)

Demo Mode
The Demo mode is highly useful for demonstration and marketing purposes, and for understanding system operation.
In Demo mode, a demo project is loaded with pre-defined sites, vessels and scanners and their configuration. A simulation of filling / emptying operations over time starts. Most software features are available in demo mode, thus it allows viewing reports, 3-dimensional profiles, logs and time-based charts and their behavior over time.

- Select **Start Demo Running** from the **Tools** menu to initiate the demo mode. A demo project selection box appears. The box includes demo projects of various types, such as Aggregates, Chemicals, Food and more. Choose a demo project and press **Select**. The demo project will load with all its sites, vessels and scanners, and the simulation will start.

- **Fast Run / Normal Run / Slow Run**: The demo mode simulation is running at an accelerated time. The simulation speed may be chosen as one of these options. By default, the Normal Run option is selected.

- **Restart Demo Running** brings the demo values to their initial levels and continues the simulation while keeping demo history.

- The Reset Demo Date (Server) option restarts the demo.

- To exit demo mode, select **Stop Demo Running** from the **Tools** menu. The demo mode stops and a project selection box appear.

**IMPORTANT**: The demo mode must be stopped before the system can return to normal operation. Exiting and restarting the application will not stop the demo mode.
Users Management

The 3DVision / 3DMultiVision software allows defining and working at several possible user levels. Each level has different authorizations for accessing system features. Multiple users can be added to the system and their authorization levels should be set.

The available user level options are:

- **Administrator** – Has all privileges except for changing scanner communication and polling address
- **Premium** – Same as Administrator, without the privilege of changing user accounts.
- **Technician** – Full control
- **Viewer** – Only viewing capabilities

To access users management, select the **Users Management** option from the Tools menu. The User Management box appears and allows adding and deleting users and setting their user name, password and authorization level.

The **Users Authorization is Enabled** check box on top, when unchecked, causes the server to ignore the defined user authorizations, which allows entering the system without a password. All users log in with Administrator privileges.

Materials Management

The software includes a convenient tool for managing stored materials which are represented by names and colors. Materials can be added to the project as required with their names defined and their colors chosen. When setting up vessels, the stored material is selected out of the list of materials created using this feature, and the color chosen for the selected material will be used to represent the vessel in the vessel display under site selection and whenever a graphical vessel representation is used.

For creating a new material, choose **Configure Material Color** from the Tools menu. This brings a similar dialog which also includes the options to add, delete or modify and store materials, their descriptions and colors, as shown below:
To add a new material:

- Enter the new material name in the **Material Name** box.
- Select its color by pressing the [...] button. A color selection box appears. Select the desired color. The vessel image will automatically change to display the stored material with the selected color. Close the color selector box.
- Press the **Add** button. The new material will be added to the list.

For editing the material details:

- Select the material to be modified from the Available Materials list, enter a new name, or select a different color and press the **Edit** button.

For deleting a material, select it from the list and press the **Delete** button.

**Parameters and Alerts**

The system allows defining and displaying alerts of various types. Alerts are shown using a circular indicator located on the vessel icons in the vessel navigation bar, in the vessel rectangular boxes (displayed on site selection) and in the vessel Overview tab. In addition, the vessel box and the overview tab provide descriptions for the alerts.

**Alert types**

The system provides alerts for configuration and different notifications using the round condition indicator:

- **System Notifications** – in red color. Occurs when a 3DLevelScanner measured temperature exceeds the allowed temperature range (-40 to +85 °C or -40 to +185 °F).
- **Alerts may appear in several colors for various failure conditions as follows:**
  - Grey: No connection
  - Orange: Wrong configuration warning
  - Red: Serious equipment malfunctioning (mostly for scanners)
  - Green: indicates a proper condition
- **Configuration Notifications** (in yellow color). Appears when the 3DLevelScanner settings are not identical to the corresponding vessel settings (all configuration wizard settings except device position and horizontal angle).
  The alert description will be displayed above the vessel image in yellow font.
- **Vessel volume alert** – it is possible to set minimum and maximum volume thresholds to alert the operator when the material stored in the silo exceeds maximum value or is below the minimum value. Such indication causes the entire vessel box to turn red in the site view (under the overview tab).

**Choosing properties to be displayed**

The software allows choosing the alerts to be indicated per vessel. To select alerts for a vessel, right-click a vessel at the vessel rectangular box (when a site is selected) and choose the **Properties**... option from the menu. The following data selection tab appears:
Data Selection

The Data Selection tab allows choosing the properties to appear in the vessel box under site selection. By default, the following properties are selected and shown:

- Distance/Level (the distance or level parameter is shown as configured)
- Maximum and Minimum Distance / Level
- Volume (%)

The box allows removing selected properties, adding properties to be displayed and changing the order they appear when displayed inside the vessel box:

- For removing a selected property, select the property for removal and press \( \text{Delete} \).
- For removing all selected properties, press \( \text{Delete} \).
- For adding a property, select the required property from the Available pane and press the \( \text{Insert} \) key.
- For adding all available properties, press the \( \text{Insert} \) key.
- For moving a selected property up, select the property from the Selected pane and press the \( \text{Up} \) key.
- For moving a selected property down, select the property from the Selected pane and press the \( \text{Down} \) key.

Setting alert threshold

The Alerts tab allows choosing the alerts threshold, which triggers an alert when the material volume is under or above these levels.
To define the alert thresholds:
- Check the required option (or both). Unchecked option will not generate an alert for this vessel.
- Set the value in volume percent where above this value (for maximum) or below this value (minimum) an alert should be generated.

Once set, an alert will be generated when the material volume exceeds the maximum value set or gets below the minimum value set.

3-Dimensional representation

The right pane of the Properties tab of a selected vessel displays a 3-dimensional representation of the vessel including the scanners located on it and the material stored, with the level and surface as measured by the scanners, and several control options.

The 3-dimensional image feature can also be activated when right-clicking a vessel box when a site is selected, and choosing the **Show 3D Profile** option.

- **Navigation stick**: allows 4-direction image tilt and rotate over the X and Y axes, including a central home button which brings the axis back to 0° position and resets magnification.
- **Magnification slider**: allows changing the image magnification in and out.
- **On Line checkbox**: When checked, the image is displayed according to the current material measurements. When unchecked, the view changes to an animation showing the stored material level and surface changes over a selectable time period (see figure below).
- Play/Stop/FF/REW animation control buttons
- Time bar with location knob
- Interval: Allows setting the frame rate in milliseconds
- [ ] button: Allows changing the animation date range
- [ ] button: Allows opening an existing animation file

Additional 3D representation related functions are available by right-clicking on the image:

- **Show Vessel Geometry Only**: Remove the material representation and leave only the vessel shape.
- **Show Device**: Shows the 3DLevelScanner(s) in their configured locations on the top of the vessel.
- **Show Fill, Empty Points**: Add small arrow icons to represent the location of the filling and emptying points based on the 3DLevelScanner configuration.
- **Material Color...**: Selecting this option opens a color selection window with various colors to select from and paint the material with.
- **Show Axes**: Add X, Y and Z Axis to the Vessel shape, the center of axis is the center of the vessel on the bottom part.
- **Activate Pan Mode**: Selecting this option allows moving the 3D image up and down and to the sides, instead of rotating it as the default operation.
- **Save Image As...**: Allows saving the currently viewed image as JPG file on the computer.
- **Misc ►**: Additional functions:
  - Show Silo Dimensions Walls: Add grid walls with dimensions
  - Draw Silo Grid (Wireframe): Add grid to the material surface
  - Show Solid Material Color: Switch the gradient material color to a single color
  - Fill Bounds With Material: Fill the bounds of material and silo with the same color as the material
  - Hide Top Shape: Hide the top part of the silo in case it is a cone, dome or pyramid
- **View ►**: Viewing the 3D image from different angles:
  - Original
  - View From Front
  - View From Top
  - View From Left
- View From Right
- View From Behind
- View 3D

Log views

When a site is selected or when a vessel is selected and its properties are shown in the main area, select the Logs tab to view its logs. This switches the main area below to display logged data in historical chart representation, for both site and vessel (see figures below).

Site Logs

Display Level/Volume based charts for all vessels defined in the site, each vessel can be un-selected from the chart.
Vessels Logs
Collected data is displayed in four charts over a selected time period for Level, Volume, SNR and Temperature of the selected vessel.
- For magnification of a selected area in the chart, hold the mouse left key over the chart and drag to create a rectangular area. When releasing the mouse button, the chart will be magnified according to the selected area.
- For panning a specific location in the chart, right click the mouse inside the chart and drag. The chart area will pan according to the dragging location.
- The button allows cancelling all zoom and pan activations that were applied on all graphs and returning back to the original display view.
- The On Line check box:
  - When checked, the charts show the current measurements.
  - When unchecked, the chart allows downloading data from the scanners or browsing for previously stored files containing the data for displaying.

Upgrading
When upgrading from 3DVision to 3DMultiVision versions, a license key is required. The change takes effect immediately. Restarting of the client PC is not required. The license key is given for a MAC address (unique for every computer).

![Update License Key dialog](Image)

- Click the Get button to retrieve the 3DVision Server computer MAC address. The MAC address is displayed, and automatically copied to the clipboard. Send the MAC address information to BinMaster for upgrade or activation.
- Enter the license key in the **Enter License key**... field.
The 3DMultiVision software may be installed and operate for up to 30 days without a license key. After 30 days, the software will require a valid license key to operate. During the 30 days period, the software will generate licensing reminder messages from time to time. Checking the **Don't remind** check box disables these reminders.

**NOTE**: One license code is required per a 3DVision Server application. The license code must be generated for the MAC address of the server computer only.
8.5 Software Menus

File Menu
- **New**: Starts a new, empty project.
- **Open**: Opens an existing project.
- **Save**: Saves the current project.
- **Save As**: Saves current project with a different name.
- **Export Project from Server**: Exports a project in XML format.
- **Import Project to Server**: Imports a project in XML format.
- **Delete Project**: Deletes a project from the server. A list of all projects stored in the server is opened for choosing a project to delete.
- **Browse to Local Folder**: Allows browsing the software installation folder.
- **Exit**: Exits 3DMultiVision.

**NOTE**: The Import and Export functions are for maintenance reasons. They allow downloading projects to a local computer for modifications, and then uploading the modified projects back to the server.

**NOTE**: Deleting projects is allowed as long as there is at least one project remaining. Deletion of the current project is not allowed.

Action Menu
The lower part of this menu changes according to the selected item. If a vessel is selected, it corresponds to a vessel connection. If a scanner is selected, it displays scanner related commands, e.g. Connect & Disconnect Scanner, Load from Scanner.
- **Connect All**: Connect to all the scanners in the selected site.
- **Disconnect All**: Disconnect from all the scanners in the selected site.
- **Connect Vessel**: Connects to all scanners of the selected vessel.
- **Disconnect Vessel**: Disconnects all scanners in the selected vessel.
- **Load from Vessel**: Downloads all the data from all scanners in the selected vessel.

Edit Menu
- **Add ►**: Add sites, vessels, or scanners depending on the level selected in the project pane. Sub-menu options:
  - On the site level, it adds sites or vessels.
  - On the vessel level, it adds scanners.
  - On the scanner level, it is disabled.
- **Delete ►**: Deletes sites, vessels, or scanners depending on the level selected in the project pane. Sub-menu options:
  - On the site level, it deletes sites.
  - On the vessel level, it deletes vessels.
  - On the scanner level, it deletes scanners.
- **Properties ►**: Sets a name and description to a site or a vessel. Sub-menu options:
  - On the site level, defines the name and description of the site.
  - On the vessel level, defines the name and description of the vessel.

### Tools Menu

The tools menu offers useful tools such as different reporting, administration tools, configuration functions and demo mode.

Reports files are created and stored in Excel worksheet format and can be opened, viewed and manipulated using Excel.

- **Reports ►**: 
  - **Export Present Project Reports from Server**: Allows selection of a date range, and retrieves a list of corresponding report files (see Figure below) from the server to select from, and allows selection of local folder to store the selected report.
  - **Browse to selected project report folder**: Opens a file browser window at the project report files location on the local hard drive. Available only if the Client is running on the same computer as the server.
  - **Show last generated report**: Opens the last generated report Excel worksheet in Excel. Available only if the Client is running on the same computer as the server.
  - **Generate report for selected vessel ►**: Allows selection of the report date and time, generates a report for the selected vessel and stores it in PDF format. There are two location options for retrieving the report data to choose from:
    - **From Local Folder**: Searches the local log folder for corresponding data.
    - **Download from Server**: Searches the server for corresponding data.

![Report Files selection](image)
- **Configure...**: Allows report creation time, repeating options, folder and file options configuration. For more details, refer to page 77: *Report configuration*.

- **Inventory summary table...**: Displays a special report including scanner details for all project scanners. For more details, refer to page 79: *Hardware Inventory*.

- **Measurements summary table...**: Displays a special report of vessel storage measurements for all project vessels. For more details, refer to page 80: *Measurement Summary*.

**NOTE**: For opening and viewing report files on Excel format, Microsoft® Excel® or OpenOffice must be installed on the computer.

**Configure Materials Color...**: Opens a window for defining new material types and set their color, to be displayed in the vessel images. For further details, refer to page 81: *Materials Management*.

- **Senior Technician Mode...**: Allows switching to Senior Technician mode, which is reserved to BinMaster only.

- **Connect to Server...**: Connects the client to a server (if not already connected), or disconnects the current connection and connects to a different server. A Server Connection dialog appears. For further details regarding server connection, refer to page 61: *First Time Running of 3DVision*.

- **Server ➤**: The server sub-menu contains several functions such as server synchronization, server information retrieval and advanced server functions.

  - **Server Version**: Retrieves and displays the server version.

  - **Server Synchronization**: Synchronizes all parameters from the 3DMultiVision Server to the client PC. When local changes have been made at a client level, while the server has different values received from the scanners, this function updates the client with the server data so both are synchronized.

  - **Advanced ➤**:
    - **Ignore External Managers**: The 3DLevelManager programs running on remote computers are connected and communicate with scanners directly, and not through a server as with the 3DVision / 3DMultiVision. This causes the 3DVision / 3DMultiVision to enter silent mode, where no data is received. Choosing the Ignore External Managers option disconnects these remote connections and exits silent mode. This option is available under Technician Mode only.

    - **Export Config Files from Server**: Export a configuration file in XML format, for support purposes.

    - **Export Trace Files from Server**: Export server trace files for support purposes.
- **Show Server Last Error**: Retrieves and displays the last error reported by the server.

- **Show Server Computer Date and Time**: Retrieves and displays the server date and time. The server date and time may be important for synchronization reasons. Client and Server computers time may differ due to geographical installation or a difference in clock settings.

- **Restart Server**: Halts server execution and causes it to restart.

- **Get Server TCP Connections**: Retrieves and displays a list of all existing connections to the server. Each displayed connection includes the local port, remote port, TCP/IP address and status.

- **Get Server Active Top Listeners**: Retrieves and displays a list of all existing connections to the server.

- **Switch User…**: Logs out the current user and logs in a different user. This function opens a window requesting the new username and password.

  **NOTE**: Each user account has its own defined permission level. Switching to a user account with a lower permission level limits the range of permissions allowed for the user.

- **Users Management…**: This function opens the Users window which displays a list of all the user accounts defined on the Server and their permission levels as shown. Refer to page 81: Users Management for more details regarding user levels and authorizations. This option is available for users with Administrators privileges only.

  The Users Management dialog enables adding, removing and changing properties of users:

  - **Add…**: Click to add a new user. A dialog opens requesting a name, password and permission level for the new user.
  - **Remove**: Select a user for removal from the list and click **Remove** to remove user.
  - **Properties**: Select a user from the list for changing their properties and click **Properties**. A dialog opens allowing changing the name, password and permission level for the selected user.

Click **Close** to accept the changes and close the Users Management dialog.

- **Configuration…**: Allows changing different visual settings of the client application. When selected, the Client Configuration box appears:

  - The Configuration dialog allows defining how vessels are displayed in the client work area. The **Number rows** field sets how many rows of vessels to display.
The **Number columns** field sets how many vessels to display in each row.

- The configuration dialog also allows adding the client's logo on the top-right corner of the client application. To add/change the logo, click the [...] button. A file browser box appears. Select your company logo file (must be of JPG, GIF, BMP or PNG extension) and click **Open**, or enter the location and file name manually in the **Logo Image File** field.

- Click **Close** to accept the changes, or **Cancel** to exit discarding changes.

- **Change Language ►**: Allows selecting the preferred client language.

- **License Key...**: Allows upgrading from the single-vessel 3DVision software license to the 3DMultiVision software license by entering a new license key. For a detailed description, refer to *page 87: Upgrading*.

- **Demo ►**: Activates the software in Demo mode, which allows selecting a demo site and performs a simulation of the operation of its various components (vessels, scanners) and creates logs.

  For further details, refer to *page 80: Demo Mode*.

### 8.6 Using 3DLevelManager with 3DVision

For troubleshooting purposes, it is possible to connect the 3DLevelManager to the scanners while the 3DVision is running and connected to the scanners.

Before connecting the manager to the 3DVision, make sure the 3DVision Server is connected to all scanners.

Execute the 3DLevelManager and open the connection window, the connection is done in TCP/IP mode:
- When running the manager on the same computer as the 3DVision server, type `localhost` (or the 3DVision Server computer address) in the IP address field
- Set the Server IP port to 22221
- Select the polling address or set to Multiple
- Establish the connection
- Note: the 3DVision Client is in silent mode and no changes are applied to the clients
Appendix A: Additional Information

9.1 Using 3DLevelScanner Onboard Buttons

Key functions are as follows:

- **ESC** Navigates back within a function menu.
  - Continuous 3 second press exits to the default screen.
- **+** Navigates upwards in the navigation list.
- **−** Navigates downwards in the navigation list.
- **E** Navigates right within a function.
- **E** Navigates left within a function.
- **E** Navigates to the right when within a function group.
  - Stores a value once configured.

The following, simultaneous key-press combinations perform special functions as follows:

- **+ E** Increase/decrease the LCD display intensity.
- **− E** Press and hold the **E** button, then use the **+** or **−** buttons to increase or decrease the intensity of the display.

9.2 3DLevelScanner Accessories

Installation flanges

The following flanges are available from BinMaster.

Flange preparation and installation guidelines

- The transducer case must fit in the opening in the vessel. If this cannot be done, use alternative solutions such as a neck extension or lowering the scanner inside the silo.
- The widest part of the scanner is the transducers case: 193.3mm (7.61")
- Insert the flange over the neck tube
- Tighten the nut to the neck thread using an 18" adjustable wrench
- Note: The diameter of the opening in the flange center is 52mm (2.05")
Flange type DN200

Flange thickness: 6.5mm (0.25")

Flange type DN250

Flange thickness: 6.5mm (0.25")
Neck Extensions

The neck extension is used for lowering the scanner body below obstructions, such as standpipes, support beams or other construction which might block the acoustic signals. Neck extensions are available in custom lengths.

The neck extension must be purchased with a compatible scanner. An adjusted antennas cable length is manufactured with the scanner and is compatible with the required neck extension.
Head-Body separation
The head body separation solution allows installing the body inside the vessel and the head in an external location where it is easy to maintain and reach.

Head-Body Separators are available in 2 sizes:
- 3m (9.85ft)
- 10m (32.8ft)

Head-Body separation dimensions:
Cable Glands

The 3DLevelScanner™ shipped with one M20 cable gland and one M20 Blind plug and supplied with accessory kit that includes:

- 1 x M20 Cable Gland
- 2 x NPT ½” adaptor

The provided glands and accessory kit will allow the installer to use any combination as he sees fit.

The available options are:

- Using one Gland and one blind
- Using two glands – unscrew the blind and attached the M20 gland
- Using conduits or ½” glands by unscrewing the existing gland or blind, attaching the NPT ½” and connecting the conduit or gland to the adaptor this can be done using one or both cable entries

9.3 Preventive Maintenance Procedure

BinMaster recommends the following periodical maintenance procedure for keeping the scanner in proper operating conditions and preventing unnecessary malfunctioning which may be caused by environmental factors over time:

- Clean the interior part of the antennas (see details below)
- Visually check and ensure the communication and power cables are in good condition and are not damaged
- Check and ensure proper sealing of cable entry openings
- Open the rear side of the scanner head and ensure absence of wetness

Antenna cleaning guidelines:

- Use a brush or wet cloth for the purpose of cleaning
- Disconnect power to the scanner
- Disassemble the flange and carefully pull out the entire scanner
- As necessary, water can be used for cleaning
- Avoid usage of sharp tools such as screwdrivers for cleaning. Such tools may damage the membranes.

Preventive maintenance frequency

The frequency of the maintenance procedure is subject to the conditions and the type of material stored in the vessel. In the case of materials such as salt, sugar, calcium carbonate or similar materials, treatments should be more frequent.
9.4 **Recommended Tools**

The following tools are recommended for the installation process:

- The site application documents (IPF, AAF) and vessel technical drawings
- A Set of small precision screwdrivers, to be used with the terminal blocks
- 13mm open wrench
- 4mm hex key (preferably with a handle)
- Large 18” adjustable wrench
- Stanley knife, Cutter, Pointed pliers, Isolating tape
- Laser measurement device (or other means to ensure correct positioning and distance to the material)
- RS485 to USB converter, including drivers
- 120 Ohm resistors
- PC/Laptop

9.5 **3DLevel Scanner Specifications**

**Technical data**

**Materials, non-wetted parts**

<table>
<thead>
<tr>
<th>Component</th>
<th>Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>Housing &amp; Antenna</td>
<td>Painted Aluminum die casting</td>
</tr>
<tr>
<td>Inspection window in housing cover</td>
<td>Polycarbonate</td>
</tr>
<tr>
<td>Ground terminal</td>
<td>Stainless steel 1.4571/1.4435</td>
</tr>
</tbody>
</table>

**Physical**

<table>
<thead>
<tr>
<th>Component</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>5.6kg (12.34lbs.)</td>
</tr>
</tbody>
</table>

**Power Supply**

<table>
<thead>
<tr>
<th>Component</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply voltage</td>
<td>20...32 VDC</td>
</tr>
<tr>
<td>Power consumption</td>
<td>max 1.5W</td>
</tr>
</tbody>
</table>

**Output variables**

<table>
<thead>
<tr>
<th>Component</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output signal</td>
<td>4-20mA</td>
</tr>
<tr>
<td>Resolution</td>
<td>10uA</td>
</tr>
<tr>
<td>Current limitation</td>
<td>22mA</td>
</tr>
<tr>
<td>Communication</td>
<td>RS485 / ModBus RTU</td>
</tr>
</tbody>
</table>

**Plugs and Cabling**

- 1 x cable entry M20x1.5 (cable-Ø 8...13mm with conductor size of 20 to 24AWG, preferable shielded twisted pairs type cable) assembled on the scanner
- 1 x blind stopper M20x1.5 assembled on the scanner
- Accessory kit with additional M20x1.5 cable gland and 2 x NPT1/2” adaptors
Display panel
Display
Adjustment elements

Load
4-wire sensor
Integration time

Load Diagram
1: HART Load
2: Voltage Limit EEx ia device
3: Voltage limit non-Ex/Exd ia device
4: Supply Voltage

Ambient conditions
Ambient/storage/transport temperature:
Relative humidity
Maximum altitude

Process conditions
Vessel pressure

Process temperature
Measured on the process fitting:
Vibration resistance:

Display panel
Display LCD 4 lines x 20 characters
Adjustment elements 4 keys (ESC, +, -, E)

Load
4-wire sensor See load diagram bellow
Integration time 0...9999 s, adjustable

Load Diagram

Ambient conditions
Ambient/storage/transport temperature:
Relative humidity 20...85%
Maximum altitude 5,000m (16,400ft)

Process conditions
Vessel pressure -0.2...3bar (-20...300 kPa or -2.9...43.5 Psi)

Process temperature
Measured on the process fitting:
Vibration resistance: Mechanical vibrations of 2g at 5...200 Hz
Appendix A: Additional Information ● 3DLevelScanner Specifications

Electrical protective measures
Protection  IP67 according to IEC 60529

Measurement characteristics
Frequency  2.65-7 kHz
Beam angle with horn antenna  70 degrees
Interval  >2 s (depending on parameter adjustment)
Adjustment time  >3 s (depending on parameter adjustment)

Power supply – 4-wire device
A safety certified power supply which provides double insulation between the primary and output must be used for powering the unit. The power supply must be a limited power source type with maximum output current 1A and voltage range of 20VDC minimum and 32VDC maximum

Approvals
ATEX  II 1/2D, 2D, Ex ibD/iaD 20/21 T110C
       II 2G Ex ia/ib IIB T4

CFMUs  Intrinsically safe CL I,II, DIV I, GP CDEFG
Comply with the following approval standards:
       CAN/CSA C22.2 No. 25, 1966
       CAN/CSA C22.2 No. 157, 1992
       CAN/CSA C22.2 No. 1010, 2004
       CAN/CSA E61241-1-1, 2002

NEPSI  Ex ibD/iaD 20/21 T110C
       Ex ia/ib IIB T4

     NSR (73/23/EWG) EN 61010-1: 2001

FCC  Conformity to part 15 of the FCC regulations
     FCC 47 CFR part 15:2007, subpart B, class A
The 3DLevelScanner complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
Dimensions

3DLevelScanner dimensions: Front view
3DLevelScanner dimensions: Side view
# MVL Controller Specifications

## Mechanical
- **MVL Controller Dimensions (H x W x D):** 50 x 30 x 15 cm (19.7 x 11.8 x 5.9 ”)
- **MVL Controller Package (H x W x D):** 67.5 x 43 x 30.5 cm (26.6 x 16.9 x 12 ”)
- **MVL Controller weight:** 12.2kg (26.9lbs)

## Operating temperature:
- **Ambient with air flow:** -5°C to 50°C (23°F to 122°F)
- **Indoor installation**
- **Storage temperature:** -20°C to 80°C (-4°F to 176°F)
- **Relative humidity:** 10% to 93% (Non-Condensing)

## Power Supply:
- **Voltage:** 20...28 VDC
- **Power consumption:** 40 Watt
Appendix B: Standards & Approvals

3DLevelScanner EMC Test Certificate for FCC Part 15, Sub-part B, Class A

Certificate No: K104551.01
Page: 1
Date of issue: 07 April 2011

Applicant: APM Automation Solutions Ltd.
Atidim Hi-Tech Industrial Park, Building 2, P.O.B 58171,
Tel Aviv 61580, Israel

Tested to: FCC Part 15, Sub-part B, Class A

Certified Product
E.U.T: 3D LevelScanner II
Model: S*, M**, MV**, MVL**
Serial No.: 25100172
* This model was actually tested.
** See customer’s declaration dated 07 April 2011 in ITL test report no. E104551.00.

This is to certify that the product specified herein has been tested and the test results were found to be compliant with the requirements noted above.

Signature: Y. Mendukkovich
EMC Test Engineer
ITL491 Rev 1.7 02/06/97

Signature: I. Raz
EMC Laboratory Manager

ITL (PRODUCT TESTING) LTD.
PRODUCT SAFETY, EMC & TELECOMS LAB.
Bak-Sheva St., P.OB 97 LOD 71100 ISRAEL
Tel. 972-3-9453100 Fax. 972-3-9453101
Email: standards@itl.co.il Web Site: http://www.itl.co.il
Appendix B: Standards & Approvals ● MVL Controller Specifications

3DLevelScanner EMC Test Certificate for:

- EN 61326-1: 2006
- CISPR 11: 2003 Class A
- IEC 61000-4-2: 2001 Air Discharge, 8kV
- IEC 61000-4-3: 2002 80-1000MHz, 1V/m; 1.4-2GHz, 1V/m; 2.0-2.7GHz, 1V/m
- IEC 61000-4-4: 2004 Power Lines: 1kV; Signal Lines: 0.5kV
- IEC 61000-4-6: 2004 0.15-80MHz 1VRMS, 80% A.M. by 1kHz Power & Signal Lines

---

**Certificate No.**

K104550.01

**Page**

1

**Date of Issue**

07 April 2011

---

**Applicant**

APM Automation Solutions Ltd.
Atidim Hi-Tech Industrial Park, Building 2, P.O.B 58171,
Tel Aviv 61580, Israel

---

**Tested to**

**EN 61326-1: 2006**
- CISPR 11: 2003, Class A

**IEC 61000-4-2: 2001**
- Air Discharge, 8kV
- Contact Discharge, 4kV

**IEC 61000-4-3: 2002**
- (80-1000 MHz), 1V/m; (1.4-2 GHz), 1V/m
- (2.0-2.7 GHz), 1V/m
- 80% A.M. by 1kHz

**IEC 61000-4-4: 2004**
- Power Lines: 1kV
- Signal Lines: 0.5kV

**IEC 61000-4-6: 2004**
- (0.15-80 MHz) 1VRMS, 80% A.M. by 1kHz

**Power and Signal Lines**

**Note:** The above list of tests was performed according to the customer's request.

---

**Certified Product**

**E.U.T.:**

3D LevelScanner II

**Model:**

S*, M**, MV**, MVL**

**Serial No.:**

25100172

* This model was actually tested.
** See customer's declaration dated 07 April 2011 in ITL test report no. E104550.00.

---

This is to certify that the product specified herein has been tested and the test results were found to be compliant with the requirements noted above.

**Signature:**

[Signature]

EMC Test Engineer

**Signature:**

[Signature]

EMC Laboratory Manager

---

I.T.L (PRODUCT TESTING) Ltd.
PRODUCT SAFETY, EMC & TELECOMS LAB.
Bat-Sheva St., POB 67 LOD 71100 ISRAEL. Tel. 972-8-9153100 Fax 972-8-9153101
Email: standards@itl.co.il, Web: http://www.itl.co.il
Find all of your level measurement needs at:
www.binmaster.com

- SmartBob2 weight & cable
- Rotaries
- Capacitance probes
- Vibrating rods
- Diaphragm switches
- Tilt switches
- Ultrasonics
- Radar
- Aeration

Call us for dust & flow detection devices, too!